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Introduction
Microsoft SQL Server is a relational database management system (RDBMS)
used for building, managing, and deploying business applications. The SQL
Server infrastructure provides services such as jobs, notification, and in-built
replication. SQL Server also uses MSSearch service for full-text search indexing
and Microsoft Distributed Transaction Coordinator (MSDTC) to co-ordinate
transactions.
The VCS database agent for Microsoft SQL provides high availability for
Microsoft SQL Server 2000 and Microsoft SQL Server 2005 in a VCS cluster. The
agent monitors Microsoft SQL Server RDBMS and its services on a VCS cluster
to ensure high availability. The VCS database agent for Microsoft SQL provides
“active/active” support for SQL Server. VCS provides separate agents for SQL
Server 2000 and SQL Server 2005.

Agents for SQL Server 2000
■

Agent for SQL Server 2000 service. The agent provides high availability for
SQL Server 2000 service.

■

Agent for MSSearch service. The agent provides high availability for
full-text search indices with a clustered SQL instance.

Agents for SQL Server 2005
■

Agent for SQL Server 2005 service. The agent provides high availability for
SQL Server 2005 service.

■

Agent for SQL Server 20005 Agent service. The agent provides high
availability for SQL Server 2005 agent service.

■

Agent for SQL Server 2005 Analysis service. The agent provides high
availability for SQL Server 2005 Analysis service.

The VCS database agent for Microsoft SQL also includes an MSDTC agent, which
provides high availability for MSDTC service used in distributed transactions.
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The agent provides high availability for MSDTC service for SQL Server 2000 and
SQL Server 2005.

About SQL Server services
The VCS database agent for Microsoft SQL provides high availability for
following services, MSSearch and MSDTC.

MSSearch service
SQL Server 2000 provides a full-text search index using the Microsoft Search
(MSSearch) service. MSSearch is an indexing service that creates and manages
full-text indices on specified columns within a database table. Full-text search
creates an index entry for each word in the textual data for a specified column.
Because each word in the textual data is indexed, queries looking for particular
words become extremely fast.

Microsoft Data Transaction Coordinator (MSDTC) service
Microsoft Data Transaction Coordinator or the MSDTC service enables you to
perform distributed transactions. A distributed transaction updates data on
more than one computer in a network. The MSDTC service ensures that a
transaction is successfully committed on each computer. A failure to commit on
a single system aborts the transaction on all systems in the network.
If a transaction spans across more than one computer in the network, you must
ensure that the MSDTC service is running on all the computers. Also, all the
computers must be able to communicate with each other.
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About the SQL Server 2000 agents
The agents for SQL Server 2000 monitor specific resources within an enterprise
application, determine the status of these resources, brings them online, and
takes them offline.

Agent for SQL Server 2000
The agent brings the SQL Server 2000 service online, monitors the status, and
takes it offline. The agent provides high availability for SQL Server 2000 in a
clustered environment. The SQL Server 2000 agent monitors the SQL Server
service and the SQL agent service. Specific agent operations include:
■

Online—Brings the SQL Server 2000 service online.

■

Offline—Takes the SQL Server 2000 service offline.

■

Monitor—Queries the Service Control Manager (SCM) for the status of
SQL Server 2000 services. See “Monitoring options” on page 13 for more
information.

■

Clean—Forcibly stops the SQL Server service.

Agent for MSSearch service
The agent brings the full-text search for a particular SQL instance online,
monitors the status, and takes it offline. The agent provides high availability for
full-text search index in a clustered environment. Specific agent operations
include:
■

Online—Brings the full-text search service for a particular instance online.

■

Offline—Takes the full-text search service for a particular instance offline.

■

Monitor—Monitors the full-text search service for a particular instance.

■

Clean—Forcibly stops the MSSearch service for a particular instance.

Note: The MSSearch agent requires the SQL Server agent to be configured.
Hence, you must configure MSSearch agent only on those cluster nodes that
have SQL Server agent configured.
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About the SQL Server 2005 agents
The agents for SQL Server 2005 monitor specific resources within an enterprise
application, determines the status of these resources, brings them online, and
takes them offline.

Agent for SQL Server 2005
The agent brings the SQL Server 2005 service online, monitors the status, and
takes it offline. The agent provides high availability for SQL Server 2005 in a
clustered environment. The SQL Server 2005 agent monitors the SQL Server
service. Specific agent operations include:
■

Online—Brings the SQL Server 2005 service online.

■

Offline—Takes the SQL Server 2005 service offline.

■

Monitor—Queries the Service Control Manager (SCM) for the status of
SQL Server 2005 services. See “Monitoring options” on page 13 for more
information.

■

Clean—Forcibly stops the SQL Server service.

Agent for SQL Server 2005 agent service
The agent brings the SQL Server 2005 agent service online, monitors the status,
and takes it offline. The agent provides high availability for SQL Server 2005
agent in a clustered environment. Specific agent operations include:
■

Online—Brings the SQL Server 2005 agent service online.

■

Offline—Takes the SQL Server 2005 agent service offline.

■

Monitor—Monitors the SQL Server 2005 agent service.

■

Clean—Forcibly stops the SQL Server 2005 agent service.

Agent for SQL Server 2005 analysis service
The agent brings SQL Server 2005 analysis service online, monitors the status,
and takes it offline. The agent provides high availability for SQL Server 2005
analysis service in a clustered environment. Specific agent operations include:
■

Online—Brings the SQL Server 2005 agent service online.

■

Offline—Takes the SQL Server 2005 agent service offline.

■

Monitor—Monitors the SQL Server 2005 agent service.

■

Clean—Forcibly stops the SQL Server 2005 agent service.
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Note: VCS database agent for Microsoft SQL does not provide an agent for
monitoring SQL Server 2005 MSSearch service. Instead, the SQL Server 2005
MSSearch service is monitored using a GenericService resource. Refer to Veritas
Cluster Server Bundled Agents Reference Guide for more information about
GenericService resources.

About the Agent for MSDTC service
The MSDTC agent comprises two parts; MSDTC client and MSDTC server. The
MSDTC client and the MSDTC server must not be configured on the same cluster
node.
The MSDTC agent brings the MSDTC service online, monitors its status, and
takes it offline. The agent provides high availability for an MSDTC service in a
clustered environment. Specific agent operations include:
■

Online—Brings the MSDTC service online.

■

Offline—Takes the MSDTC service offline.

■

Monitor—Monitors the MSDTC service.

■

Clean—Forcibly stops the MSDTC service.

Monitoring options
The VCS database agent for Microsoft SQL provides two levels of application
monitoring: basic and detail. Basic monitoring queries the SCM to verify
whether the SQL Server services are continuously active. Detail monitoring
updates a temporary table in the SQL Server database to verify the availability
of the database instance. See “Detail monitoring of a SQL Server database
instance” on page 80 for instructions on configuring detail monitoring for a SQL
Server database.
If you start the SQL server services from outside VCS, then the SQL resource will
go in an UNKNOWN state, because the VCS database agent for Microsoft SQL
monitors the computer context of the services. If the SQL service is not started
in the virtual server context the resource goes in an UNKNOWN state. You must
ensure that you start all the SQL related services from within VCS.
Note: Detail monitoring can be configured only for the SQL Server 2000 and SQL
Server 2005 agents.
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How the agent detects application failure
Detecting failure of SQL Server 2000/2005
The SQL Server 2000 agent monitors the SQL Server 2000 service and the SQL
agent service. If the SQL Server 2000 service is not running, the agent returns a
failure status. If the SQL agent service is not running, the agent declares the
state as UNKNOWN.
Table 1-1

SQL agents behavior

SQL Server
2000 Service

SQL 2000
Agent Service

Action taken by the Monitor routine

STARTED

STARTED

Returns the state as ONLINE.

STARTED

STOPPED

Attempts to start the SQL agent service. If the
monitor routine succeeds, it returns ONLINE.
Otherwise, it returns UNKNOWN.

The SQL Server 2005 agent monitors only the SQL Server 2005 service. If the
SQL Server 2005 service is not running, the agent returns a failure status and
declares the state as OFFLINE.
The VCS database agent for Microsoft SQL provides a sample script for detail
monitoring of the SQL database. The script contains SQL statements and is
available under the directory %VCS_HOME%\Samples. If detail monitoring is
enabled, the agent launches this script. If the SQL statements are executed
successfully, the agent declares the service group as online.
Other than the default sample script, you can provide a custom script file for
detail monitoring of the SQL Server database.

Detecting failure of SQL Server 2000 configured with
MSSearch
If SQL Server is configured with MSSearch, the MSSearch instance is attached to
a particular SQL instance. In such a scenario, the agent also monitors the state
of the MSSearch service for the particular SQL instance. If the MSSearch
instance is not detected, the agent declares only the MSSearch service as
OFFLINE.
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Detecting failure of SQL Server 2005 agent service
The agent for SQL Server 2005 agent service monitors the SQL Server 2005
agent service. If the agent does not detect the SQL Server 2005 agent service, the
agent declares the SQL Server 2005 agent service as OFFLINE.

Detecting failure of SQL Server 2005 analysis service
The agent for SQL Server 2005 analysis service monitors the SQL Server 2005
analysis service. If the analysis service is not detected, the agent declares the
SQL Server 2005 analysis service as offline.

Detecting failure of MSDTC
The MSDTC agent monitors the MSDTC service to detect failure. The agent
detects an MSDTC failure if the MSDTC service is not running.

Running SQL Server in an Active/Active clustered
environment
SQL Server supports up to 16 independent instances of SQL Server to run on a
single machine. A SQL Server instance can fail over to any of the other
configured nodes on its system list. You can choose an active/active SQL Server
configuration where several instances are intended to run on a single node.
However, remember that you must configure failover nodes so that a single node
can never host more than 16 instances.

Installing SQL Server 2000 in an Active/Active environment
To install SQL Server 2000 in an Active/Active Environment, you must repeat all
of the procedures in “Installing and configuring SQL Server” on page 21,
“Installing the Microsoft SQL database agent” on page 47, and “Configuring a
SQL Server service group” on page 51 for each additional instance in an
active/active configuration.
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Typical SQL Server 2000 configuration in a VCS
cluster
A typical SQL Server 2000 configuration in a VCS cluster involves two cluster
nodes accessing a shared storage. The SQL Server binaries are installed on the
cluster nodes. The shared storage is used to store SQL Server data files and the
MSDTC log files. The cluster nodes access the shared storage.
The cluster nodes are configured to host the SQL Server 2000 and SQL Server
2000 MSSearch resource. The MSDTC resource can be configured on the same
cluster nodes. You need not configure an MSDTC client if the MSDTC resource is
configured on the same nodes that have SQL Server 2000 resource configured.
However, if the MSDTC resource is configured on other nodes, you must
configure an MSDTC client to point to the virtual server name of the MSDTC
resource.
The following illustration depicts a two node cluster hosting a SQL Server
service group with MSSearch service configured. MSDTC resource is also
configured on the same nodes.
Figure 1-1

Typical SQL Server 2000 configuration in a VCS cluster
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Typical SQL Server 2005 configuration in a VCS
cluster
A typical SQL Server 2005 configuration in a VCS cluster involves two cluster
nodes accessing a shared storage. The SQL Server binaries are installed on the
cluster nodes. The shared storage is used to store SQL Server data files and the
MSDTC log files. The cluster nodes access the shared storage.
The cluster nodes are configured to host the SQL Server 2005 resource, the SQL
Server 2005 agent service resource, the SQL Server 2005 MSSearch service
resource, and the SQL Server 2005 analysis service resource. The MSDTC
resource can be configured on the same cluster nodes. You need not configure
an MSDTC client if the MSDTC resource is configured on the same nodes that
have SQL Server 2005 resource configured. However, if the MSDTC resource is
configured on other nodes, you must configure an MSDTC client to point to the
virtual server name of the MSDTC resource.
The following illustration depicts a two node cluster hosting a SQL Server
service group with the different services configured. MSDTC resource is also
configured on the same nodes.
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Figure 1-2

Typical SQL Server 2005 configuration in a VCS cluster
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Setting up a SQL Server cluster
Setting up a SQL Server cluster in a VCS environment involves the following
tasks:
■

Setting up a VCS cluster. Refer to the Veritas Cluster Server Administrator’s
Guide for instructions.

■

Installing and configuring SQL Server. See “Installing and configuring SQL
Server” on page 21 for more information.

■

Installing the VCS database agent for Microsoft SQL. See “Installing the
Microsoft SQL database agent” on page 47 for more information.

■

Configuring a SQL Server service group. See “Configuring a SQL Server
service group” on page 51 for more information.

Each task is described in detail in subsequent chapters.
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2

Installing and configuring
SQL Server
A basic configuration of SQL Server has one or more instances of SQL Server in
the cluster. Each instance is managed by a service group that is configured with
a distinct set of nodes in the cluster. Also, SQL Server 2000 and SQL Server 2005
instances can co-exist on a cluster node.
Figure 2-1

SQL Server basic configuration in VCS
VCS Private Network

Shared Storage/Cluster Disk Groups

Node B

Node A
Public Network

This chapter describes steps to install SQL Server 2000 and SQL Server 2005 in a
VCS cluster. The procedures in this chapter ensure installations of SQL Server
are uniform throughout the cluster. When you complete the installation, each
node that will participate in a SQL Server service group will have a copy of the
SQL program files located on the local disk, and access to a single copy of the
SQL data files on a shared storage.
For more information on installing SQL Server, refer to the Microsoft SQL
Server documentation.
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Supported software
■

Microsoft SQL servers and their operating systems. Note that all systems
must be running the same operating system:
■

Microsoft SQL Server 2000 Standard Edition or Enterprise Edition (SP4
required)
with
Windows Server 2003 (32-bit): Standard Edition, Enterprise Edition, or
Datacenter Edition (SP1 required for all editions)
or
Windows Server 2003 R2 (32-bit): Standard Edition, Enterprise Edition,
or Datacenter Edition
or
Windows 2000 Server, Advanced Server, or Datacenter Server (all
require Service Pack 4 with Update Rollup1)

or
■

Microsoft SQL Server 2000 (64-bit), Enterprise Edition
with
Windows Server 2003 for Itanium-based systems: Enterprise Edition,
or Datacenter Edition (SP1 required for both)

or
■

Microsoft SQL Server 2000 Standard Edition or Enterprise Edition (SP4
required)
with
Windows Server 2003 x64 Editions (for AMD64 or Intel EM64T) for:
Standard x64 Edition, Enterprise x64 Edition, or Datacenter x64
Edition
or
Windows Server 2003 x64 Editions (for AMD64 or Intel EM64T) for:
Standard x64 R2 Edition, Enterprise x64 R2 Edition, or Datacenter x64
R2 Edition

■

Microsoft SQL Server 2005 (32-bit) Standard Edition or Enterprise
Edition (SP1 required)
with
Windows Server 2003 (32-bit): Enterprise Edition, or Datacenter
Edition (SP1 required)
or
Windows Server 2003 R2 (32-bit): Standard Edition, Enterprise Edition,
or Datacenter Edition

or
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■

Microsoft SQL Server 2005 (64-bit) Standard Edition or Enterprise
Edition (SP1 required)
with
Windows Server 2003 for Itanium-based systems: Enterprise Edition or
Datacenter Edition (SP 1 required)
or
Windows Server 2003: Standard x64 Edition, Enterprise x64 Edition, or
Datacenter x64 Edition
or
Windows Server 2003 x64 Editions (for AMD64 or Intel EM64T):
Standard x64 R2 Edition, Enterprise x64 R2 Edition, or Datacenter x64
R2 Edition

Note: Microsoft SQL Server 2000 and Microsoft SQL Server 2005 can exist
in the same cluster and operate on or fail over to the same systems.
However, only one default instance can exist on a system at one time.
Additional instances that operate on or fail over to that system must be
named instances. The number of named instances is limited only by the
normal limit of instances for that version of SQL Server.
■

Microsoft SQL Server 2000
with
Veritas Storage Foundation HA 5.0 for Windows (SFW HA) with Veritas
Cluster Server Database Agent for Microsoft SQL

■

Microsoft SQL Server 2005
with
Veritas Storage Foundation HA 5.0 for Windows (SFW HA) with Veritas
Cluster Server Database Agent for Microsoft SQL

23

24 Installing and configuring SQL Server
Prerequisites for SQL Server 2000

Prerequisites for SQL Server 2000
■

Verify that all nodes have adequate resources to run SQL Server 2000 and
Veritas Storage Foundation HA 5.0 for Windows (SFW HA).

■

Verify that SFW HA is installed on all nodes in the cluster. Refer to the
Veritas Storage Foundation and High Availability Solutions, Installation and
Upgrade Guide for installation steps.

■

Verify that you have run VCW to configure VCS on all nodes. Refer to the
Veritas Cluster Server Administrator’s Guide for configuration instructions.

■

Verify that the network and the systems support the TCP/IP protocol.

■

Ensure that you have an external, basic disk to create a cluster disk group.
You must also create a volume on a cluster disk group before you can install
SQL Server. See “Managing storage using SFW” on page 25 for instructions.

■

If your cluster has an Exchange service group configured, make sure to
install SQL Server on a node, which is not in the SystemList attribute for the
Exchange service group.

Prerequisites for SQL Server 2005
■

Verify that all nodes have adequate resources to run SQL Server 2005 and
Veritas Storage Foundation HA 5.0 for Windows (SFW HA).

■

Verify that Veritas Storage Foundation HA 5.0 for Windows (SFW HA) is
installed on all nodes in the cluster. Refer to the Veritas Storage Foundation
and High Availability Solutions, Installation and Upgrade Guide for
installation steps.

■

Verify that you have run VCW to configure VCS on all nodes. Refer to the
Veritas Cluster Server Administrator’s Guide for configuration instructions.

■

Verify that the network and the systems support the TCP/IP protocol.

■

Ensure that you have an external, basic disk to create a cluster disk group.
You must also create a volume on a cluster disk group before you can install
SQL Server. See “Managing storage using SFW” on page 25 for instructions.

■

If your cluster has an Exchange service group configured, make sure to
install SQL Server on a node, which is not in the SystemList attribute for the
Exchange service group.
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Managing storage using SFW
Veritas Storage Foundation for Windows (SFW) manages data by creating disk
groups from physical disks. These disk groups are further divided into volumes,
which can be mounted from the cluster nodes.
Symantec recommends that you have a minimum of two volumes on shared
disks, one each for SQL Server data and registry replication information. If you
will be configuring an MSDTC service group, create additional volumes for
MSDTC log and MSDTC registry replication. These volumes must be accessible
from all cluster nodes. Perform the following tasks to create volumes and make
them accessible from cluster nodes:
■

Create disk groups. See “Creating disk groups” on page 25.

■

Import disk groups. See “Importing disk groups” on page 26.

■

Create volumes on disk groups. See “Creating volumes” on page 26.

■

Mount volumes. See “Mounting volumes” on page 31.

Creating disk groups
This section describes how to create disk groups.
To create a dynamic (cluster) disk group
1

Open the VEA console by clicking Start > All Programs >Symantec> Veritas
Storage Foundation >Veritas Enterprise Administrator and select a profile
if prompted.

2

Click Connect to a Host or Domain.

3

In the Connect dialog box, select the host name from the pull-down menu
and click Connect.
To connect to the local system, select localhost. Provide the user name,
password, and domain if prompted.

4

To start the New Dynamic Disk Group wizard, expand the tree view under
the host node, right click the Disk Groups icon, and select New Dynamic Disk
Group from the context menu.

5

In the Welcome screen of the New Dynamic Disk Group wizard, click Next.
■

Click the checkbox for Create cluster group.

■

Select the appropriate disks in the Available disks list, and use the Add
button to move them to the Selected disks list.
Optionally, check the Disk names prefix checkbox and enter a disk
name prefix to give the disks in the disk group a specific identifier. For
example, entering TestGroup as the prefix for a disk group that
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contains three disks creates TestGroup1, TestGroup2, and TestGroup3
as internal names for the disks in the disk group.
■

Click Next.

6

Click Next to accept the confirmation screen with the selected disks.

7

Click Finish to create the new disk group.

The newly created disk group is automatically imported on the system where
you ran the wizard. For instructions on importing disk group on other systems,
see “Importing disk groups” on page 26.

Importing disk groups
These steps describe how to import a disk group.
To import a disk group
1

From the VEA console, right-click a disk name in the dynamic group or the
dynamic group name in the General tab or tree view.

2

Click Import Dynamic Disk Group from the menu.

3

In the Import Dynamic Disk Group dialog box, click OK.

Creating volumes
This section describes how to create volumes.
To create a volume
1

From the VEA console’s tree view, select the disk group on which to create a
volume.

2

Right-click the selected disk and then click New Volume....

3

In the New Volume Wizard, read the welcome information and click Next.
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4

In the Assign Disks for Volume panel, assign disks to the volume, and click
Next.

Group name

From the drop-down list, select the disk group on
which to create a volume.

Auto select disks

Check Auto select disks if you want automatic
disk selection.

Manually select disks

Check this option to manually select the disks.
Symantec recommends using the Manually select
disks option.

Available disks

If you checked the Manually select disks option,
then select the appropriate disks and click Add to
move them in the Selected disks box.
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5

Specify the attributes for the volume and click Next.

Volume name

Type a name for the volume. The name is limited to 18 ASCII
characters and cannot contain spaces or forward or backward
slashes.

Size

Specify the size for the volume.
If you click on the Max Size button, a size appears in the Size
box that represents the maximum possible volume size for
that layout in the dynamic disk group.

Layout

Specify the layout preferences for the volume. To select
mirrored striped, click both the Mirrored checkbox and the
Striped radio button.

Mirror Info

Specify the mirror information for the volume, if applicable.
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6

Assign a drive letter to the volume and then click Next.

Assign a drive letter

Click this option, and from the drop-down list select the
drive letter to be assigned.
Verify the availability of the drive letter on all the systems
before assigning it. You must use the same drive letter on
all the systems in the cluster.
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7

Create a file system on the new volume and then click Next.

Format this volume

Check this option, if not already checked.

Select a file system

Click NTFS.

Allocation size

From the drop-down list select an
allocation size.

File system label

Type a label for the volume.

8

Review the information in the Summary dialog box and click Finish.

9

Repeat step 1 through step 8 for all the volumes to be created.
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Mounting volumes
Mounting a volume involves importing the disk group and assigning a drive
letter or the folder path. Unmounting a volume involves removing the drive
letter or the folder path and deporting the disk group.
To mount a volume
1

On the Windows taskbar, click Start > All Programs > Symantec > Veritas
Storage Foundation > Veritas Enterprise Administrator.

2

On the Veritas Enterprise Administrator (VEA) screen, click File > Connect.

3

On the Connection dialog box, type the host name, and click OK.

4

In the left pane of the VEA console, select a system name and click the plus
sign (+) next to the system name to expand the tree view.

5

If the disk group is not imported, import it. Right-click the disk group and
then click Import Dynamic Group.

6

Right-click the volume and then click File System > Change Drive Letter and
Path.

7

In the Drive Letter and Paths dialog box, click Add.

8

In the Assign Drive Letter panel, choose one of the following options
depending on whether you want to assign a drive letter to the volume or
mount it as a folder, and click OK.
■

To assign a drive letter
Select Assign a Drive Letter and select a drive letter from the
drop-down list.

To mount the volume as a folder
Select Mount as an empty NTFS folder and click Browse to locate an
empty folder on the shared disk.
You must ensure that you use the same disk on all the nodes. To identify a
disk, run vmgetdrive -details from the command prompt on one
node. Note the disk number and signature of the disk. Rerun the command
on the second node and identify the disk that has the same signature as the
one on the first node. Once you have identified two identical disks, assign
the same drive letter to the volumes on each disk.
■

9

Click OK.

10 Repeat step 6 through step 9 for all the volumes to be mounted.
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Installing and configuring SQL Server 2000
This section describes steps to install and configure SQL Server 2000 on the first
cluster node and failover cluster nodes.

Installing and configuring SQL Server 2000 on the first node
Perform the installation and configuration tasks on the first node in the cluster.
Then repeat the steps on each failover node in the cluster, as instructed under
“Installing and configuring SQL Server 2000 on failover nodes” on page 35.

Overview of tasks
Complete the following tasks:
■

Create volumes on the shared storage. See “Creating volumes” on page 26
for more information.

■

Mount volumes for the SQL Server 2000 installation. See “Mounting
volumes” on page 31 for more information.

■

Install SQL Server 2000 on the first node. See “Installing SQL Server 2000”
on page 33 for more information.

■

Unmount the volumes. See “Unmounting the volumes” on page 34 for more
information.
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Installing SQL Server 2000
Before installing Microsoft SQL Server 2000, verify that the cluster disk group is
imported on the first node and the volumes are mounted (are assigned drive
letters).
Install Microsoft SQL Server 2000 on the first node using the installation wizard
from the Microsoft software disk. Install the SQL program files on a local disk
and the SQL data files on a shared storage managed using SFW. Use the
following guidelines to install SQL Server to function properly in a VCS
environment.
Note: This section describes steps required for a SQL Server installation in a VCS
environment. Refer to Microsoft SQL Server 2000 documentation for detailed
installation information.
To install SQL Server 2000
1

Insert the SQL Server 2000 software disk in a disk drive connected to the
node and run the Setup program.

2

From the browser menu, select SQL Server 2000 Components > Install
Database Server.

3

If you are installing SQL Server 2000 on a node running a flavor of Windows
Server 2003, a dialog box appears informing that SQL Server 2000 SP2 and
below is not supported on this version of Windows. Click Continue.

4

Read the information in the Welcome panel and click Next.

5

In the Computer Name panel, choose Local Computer option and click Next.
Proceed through the installation to the Installation Definition dialog box.

6

In the Installation Definition panel, choose the Server and Client Tools
option and click Next.

7

In the Instance Name panel, select the default instance or type an instance
name and click Next. Use the same instance name when installing SQL
Server 2000 on failover nodes.

8

In the Setup Type panel, select the type of installation and click Browse to
specify the destination folder for installing SQL Server program and data
files.

9

In the Choose Folder dialog box, make the following selections and click
Next.
■

For Program Files, select a volume on the local disk.
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■

For Data Files, select the volume mounted using SFW. Allow the
rest of the path (\Program Files\Microsoft SQL Server) to
remain.

10 In the Service Accounts dialog box, make the following selections and click
Next:
■

Choose the Customize the settings for each service option.

■

In the Services box, choose SQL Server option.

■

In the Service Settings box, select the type of user account. Select Use
the Local System account if you do not want to replicate data.
Otherwise, select Use a Domain User account.

■

If you chose to run the service in the context of a domain user, specify
the information for the user.

■

Clear the Auto Start Service option.

■

Repeat these steps for the SQL Server Agent option.

11 Follow the wizard instructions to complete the installation. Reboot the node
if prompted to do so.
12 Install Service Pack 4 or higher for SQL Server 2000. Refer to Microsoft
documentation for further information.

Unmounting the volumes
These steps describe how to unmount volumes.
To unmount a volume
1

Stop the SQL Server service from the Service Control Manager (SCM).

2

Open the Veritas Enterprise Administrator. Click Start > All Programs >
Symantec > Veritas Storage Foundation > Veritas Enterprise Administrator.

3

From the VEA console’s tree view, right-click on the volume and then click
File System > Change Drive Letter and Path.

4

On the Drive Letter and Paths dialog box, select Remove and then click OK.

5

Repeat step 3 through step 4 for all the volumes to be unmounted.

6

From the VEA console’s tree view, right-click the disk and then click Deport
Dynamic Group.
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Installing and configuring SQL Server 2000 on failover nodes
To ensure application installations are identical, the values you specify while
installing and configuring SQL Server 2000 on failover nodes must match the
values specified during the installation on the first node. Use the following steps
to install and configure SQL Server 2000 on each failover node.
Note: If the failover node is already a member of the system list of a functional
SQL Server 2000 service group in the cluster, verify that SQL Server 2000 is
installed on a volume with the same drive letter as the first node and proceed to
“Configuring SQL Server in a VCS cluster” on page 52. If the failover node is not
a member of the system list of an existing functional SQL Server 2000 service
group in the cluster, proceed with the following steps.

Overview of tasks for the failover node
Before proceeding, ensure that the SQL server service is stopped on the first
node.
■

Import the disk group. See “Importing disk groups” on page 26 for more
information.

■

Mount the volumes (using the same drive letter as assigned on the first
node). See “Mounting volumes” on page 31 for more information.

■

Rename the previous SQL Server 2000 installation directory on the shared
disk.

■

Install SQL Server 2000 on the failover node. See “Installing SQL Server
2000” on page 33 for more information.

■

Unmount the volumes. See “Unmounting the volumes” on page 34 for more
information.

After you have installed and configured SQL Server 2000 on all the failover
nodes, you must set the internal name of the SQL server to a clustered instance
name. See “Setting the internal name to clustered instance” on page 36 for more
information.
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Setting the internal name to clustered instance
Use the SQL Query Analyzer to set the internal name of the SQL instance to the
clustered instance name. Before you proceed ensure that the volume containing
the SQL data files is mounted, and the SQL Server service is started.
Note: Perform these steps only once per instance and must be done after SQL
Server is installed and configured on the last failover node.
To set the internal name to a clustered instance
1

Start the SQL Query Analyzer. Click Start > All Programs > Microsoft SQL
Server > Query Analyzer.

2

In the Connect to SQL Server dialog box, select the system on which SQL
Server was installed last.

3

Specify valid user credentials.

4

■

If you select Windows authentication, the user credential with which
you are logged in is applicable by default.

■

If you select SQL Server authentication, enter a valid username and
password.

Click OK.
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5

In the Query dialog box, perform the following steps:
■

Retrieve the SQL Server name
■

Type sp_helpserver in the upper pane.

Press F5.
Make a note of the name listed in the lower pane. For a default instance,
the name will be System Name. For a named instance, the name will be
System Name\Instance Name.
You must provide this name in the next step.
■

■

■

Disconnect the database
■

Delete the contents in the upper pane.

■

Type sp_dropserver ‘name of the system displayed in
previous step’

■

Press F5.

Reconnect the database using the clustered instance name
■

Delete the contents in the upper pane

■

Type sp_addserver ‘name of clustered instance’,
local

■

Press F5.

6

Exit the SQL Query Analyzer.

7

Stop the SQL Server instance.

8

Unmount the volumes. See “Unmounting the volumes” on page 34 for
instructions.

9

Proceed to “Installing the Microsoft SQL database agent” on page 47 for
instructions on installing the agent.
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Installing and configuring SQL Server 2005
This section describes steps to install and configure SQL Server 2005 on the first
cluster node and failover cluster nodes.

Installing and configuring SQL Server 2005 on the first node
Perform the installation and configuration tasks on the first node in the cluster.
Then repeat the steps on each failover node in the cluster, as instructed under
“Overview of tasks for the failover node” on page 43.

Overview of tasks
■

Create volumes on the shared storage. See “Creating volumes” on page 26
for more information.

■

Mount volumes for the SQL Server 2005 installation. See “Mounting
volumes” on page 31 for more information.

■

Install SQL Server 2005 on the first node. See “Installing SQL Server 2005”
on page 39 for more information.

■

Unmount the volumes. See “Unmounting the volumes” on page 42 for more
information.
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Installing SQL Server 2005
Before installing SQL Server 2005, verify the shared drives created to store SQL
data are mounted on the node where you run the wizard.
Install the SQL program files to a local disk and the SQL data files to the shared
storage managed by the cluster disk group. As you progress through the
installation, use the following guidelines to create an installation that will
function properly in your environment.
Note: Only the portions of the SQL Server installation procedure relevant to the
SFW environment are documented. Refer to the Microsoft SQL Server 2005
documentation for detailed installation information.
To install SQL Server 2005
1

To begin the SQL Server 2005 installation, navigate to the installation
directory, launch splash.hta, and review the hardware and software
requirements for SQL 2005.

2

Under the Install section, select Server components, tools, Books Online,
and samples. Continue with the installation, following the instructions from
Microsoft. Complete the SQL Server Component Update, System
Configuration Check, and Registration Information pages.

3

In the Components to Install dialog box:
■

Select the SQL Server Database Services.

■

Select the optional components:

■

■

Analysis Service

■

Notification Services

■

Integration Services

■

Workstation Components

Click the Advanced option.
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4

In the Feature Selection dialog box, specify the path for SQL Server data
files and other services.
■

Expand SQL Server Database Services and select Data Files.

■

Select Browse to reset the installation path.

■

Set the installation path in the Change Folders dialog box to the drive
letter and location of the volume created for the SQL Server system
data files (INST1_DATA_FILES). Allow the rest of the path (Program
Files\Microsoft SQL Server) to remain and click OK.
This must be the same as the path on all nodes.

■

If you selected the Analysis Services option in step n on page 39,
expand Analysis Services, select Data Files, and click Browse to specify
the same location as for the SQL Server data files.
This must be the same as the path on all nodes.

■

Click Next.

5

In the Instance Name dialog box, type an instance name or accept the
default and click Next. Only one default instance is allowed per cluster. Use
the same instance name when installing SQL Server 2005 on the first node
and on all failover nodes.

6

In the Service Accounts dialog box:
■

Select the type of user account. Select Use the built-in System account
if you do not want to replicate data. Otherwise, select Use a domain
user account.

■

If you chose to run the service in the context of a domain user, specify
the information for the user.

■

Clear all the check boxes that start services.

■

Click Next.

7

Follow the wizard instructions to complete the installation. Reboot if
prompted.

8

Set SQL services to manual start.
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Setting SQL Server 2005 services to manual start
If you did not clear the Auto-start Service option during installation, set all SQL
Server services to manual start.
To set SQL Server services to manual start
1

Access the SQL Server Configuration Manager. Click Start > All Programs >
Microsoft SQL Server 2005 > Configuration Tools > SQL Server
Configuration Manager.

2

Access SQL Server properties:

3

4

■

In the left pane, select SQL server 2005 Services.

■

Right-click SQL Server instance name in the right pane.

■

Select Properties.

To set Start Mode.
■

Click the Service tab.

■

Select Start Mode.

■

Select Manual in the drop down list.

■

Click OK.

Repeat for all other SQL Server services that are running on the server for
this specific instance.

Stopping the SQL Server 2005 service
Stop a running SQL Server service on the configured node so that the databases
on the shared disk can be manipulated by the installation on the second node.
To stop the SQL Server service
1

Access the SQL Server Configuration Manager. Click Start > All Programs >
Microsoft SQL Server 2005 > Configuration Tools > SQL Configuration
Manager.

2

Access SQL Server 2005 Services:

3

■

In the left pane of the SQL Server Configuration Manager, select SQL
Server 2005 Services.

■

Right-click the SQL Server instance in the right pane.

■

Select Stop.

Repeat for all other SQL Server services that are running on the server.
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Unmounting the volumes
These steps describe how to unmount volumes.
To unmount a volume
1

Stop the SQL Server service from the Service Control Manager.

2

Open the Veritas Enterprise Administrator. Click Start > All Programs >
Symantec > Veritas Storage Foundation > Veritas Enterprise Administrator.

3

From the VEA console’s tree view, right-click on the volume and then click
File System > Change Drive Letter and Path.

4

On the Drive Letter and Paths dialog box, select Remove and then click OK.

5

Repeat step 3 through step 4 for all the volumes to be unmounted.

6

From the VEA console’s tree view, right-click the disk and then click Deport
Dynamic Group.
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Installing and configuring SQL Server 2005 on failover nodes
To ensure that application installations are identical, the values you specify
while installing and configuring SQL Server 2005 on failover nodes must match
the values specified during the installation on the first node. Use the following
steps to install and configure SQL Server 2005 on each failover node.
Note: If the failover node is already a member of the system list of a functional
SQL Server 2005 service group in the cluster, verify that SQL Server 2005 is
installed on a volume with the same drive letter as the first node and proceed to
“Configuring SQL Server in a VCS cluster” on page 52. If the failover node is not
a member of the system list of an existing functional SQL Server 2005 service
group in the cluster, proceed to the steps below.

Overview of tasks for the failover node
Before proceeding, make sure the SQL server service is stopped on the first
node.
■

Import the disk group. See “Importing disk groups” on page 26 for more
information.

■

Mount the volumes (using the same drive letter as assigned on the first
node). See “Mounting volumes” on page 31 for more information.

■

Rename the previous SQL Server 2005 installation directory on the shared
disk.

■

Install SQL Server 2005 on the failover node. See “Installing SQL Server
2005” on page 39 for more information.

■

Unmount the volumes. See “Unmounting the volumes” on page 34 for more
information.

After you have installed and configured SQL Server 2005 on all the failover
nodes, you must set the internal name of the SQL server to a clustered instance
name. See “Setting the internal name to clustered instance” on page 44 for
instructions.
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Setting the internal name to clustered instance
Use the SQL Server Management Studio to set the internal name of the clustered
instance to be the virtual server name. Before you proceed ensure that the
volume containing the SQL data files is mounted, and the SQL Server service is
started.
Note: Perform these steps only once per instance and must be done after SQL
Server is installed and configured on the last failover node.
To set the internal name to a clustered instance
1

Start the SQL Server Management Studio. Click Start > All Programs >
Microsoft SQL Server 2005 > SQL Server Management Studio.

2

In the Connect to Server dialog box, provide the connection information:

3

■

Select the server type.

■

Enter the server name in the format system_name/intance_name. For a
default instance, enter only the system name.

■

Select the appropriate authentication mechanism.

■

Enter valid user credentials if using Domain Authentication

■

Click Connect.

Open a new query window in the right pane.
■

From the Object Explorer in the left pane, right-click the SQL Server
instance name that will be set to the virtual server name.

■

From the pop-up menu, click New Query. A query window appears in
the right pane.
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4

Perform the following steps in the query window:
■

■

■

Retrieve the SQL Server name
■

Type sp_helpserver in the upper pane.

■

Press F5.

■

Make a note of the name listed in the lower pane. For a default
instance, the name will be System Name. For a named instance, the
name will be System Name\Instance Name.
You must provide this name in the next step.

Disconnect the database
■

Delete the content in the upper pane.

■

Type sp_dropserver ‘name of the system displayed in
previous step\instance_name’.

■

Press F5.

Reconnect the database using the clustered instance
■

Delete the contents in the upper pane.

■

Type sp_addserver ‘name of clustered instance’,
local

■

Press F5.

5

Exit the SQL Server Management Studio.

6

Stop the SQL Server instance.

7

Unmount the volumes. See “Unmounting the volumes” on page 42 for
instructions.
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3

Installing the Microsoft
SQL database agent
This chapter describes how to install the VCS database agent for Microsoft SQL
in a VCS cluster. The agent is installed using the installer for Veritas Storage
Foundation for Windows. The installer installs the agent on selected nodes in
the cluster and adds the SQL Server resource types to the cluster configuration.

Prerequisites for SQL Server 2000
This section lists the prerequisites for installing VCS database agent for
Microsoft SQL Server 2000 in a VCS cluster.
■

Verify that SFW HA is installed on all nodes in the cluster. Refer to the
Veritas Storage Foundation and High Availability Solutions, Installation and
Upgrade Guide for installation steps.

■

Verify you have local administrator privileges on the node where you are
installing the agent.

■

Verify SQL Server 2000 is installed and configured identically on all nodes
in the cluster.
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Prerequisites for SQL Server 2005
This section lists the prerequisites for installing VCS database agent for
Microsoft SQL Server 2005 in a VCS cluster.
■

Verify that Veritas Storage Foundation HA 5.0 5.0 for Windows (SFW HA) is
installed on all nodes in the cluster. Refer to the Veritas Storage Foundation
and High Availability Solutions, Installation and Upgrade Guide for
installation steps.

■

Verify you have local administrator privileges on the node where you are
installing the agent.

■

Verify SQL Server 2005 is installed and configured identically on all nodes
in the cluster.
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Installing the agent
Repeat these steps on all systems where VCS database agent for Microsoft SQL is
to be installed.
To install the agent
1

Start the installer for SFW. In the Add/Remove Programs applet, click
Veritas Storage Foundation 5.0 for Windows and click Change.

2

In the Veritas Storage Foundation 5.0 for Windows panel, click Add or
Remove and click Next.

3

In the SFW product options panel, click Next.

4

Check Veritas Cluster Server Database Agent for SQL and click Next.
The disk space required for the installation is displayed towards the bottom
of the screen. When you add or remove an option, the total space changes.

5

The installer validates the system for prerequisites. After the system is
accepted, click Next.
If a system is rejected, the Comments column displays the cause for
rejecting the system. Highlight the system to view detailed information
about the failure in the Details box. Resolve the error, highlight the system
from the list, and click Validate Again.

6

An informational message appears if you selected the DMP option. Review
the information and click OK to continue.

7

Review the summary of your selections and click Update to start the
installation. The installer displays the status of installation.

8

After the installation is complete, review the installation report and click
Next and then click Finish.

9

Repeat step 1 through step 8 on all systems where VCS database agent for
Microsoft SQL is to be installed.
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Configuring a SQL Server
service group
Configuring a SQL Server service group involves two major tasks, configuring a
SQL Server service and configuring an MSDTC service group. This chapter
provides instructions on configuring the SQL Server service. For instructions on
configuring an MSDTC service group, see “Configuring an MSDTC service
group” on page 61.
VCS provides several ways to configure a service group, including the service
group configuration wizard, Cluster Manager (Java Console), Cluster Manager
(Web Console), and the command line. This chapter provides instructions on
how to configure the service group using the configuration wizard.

Prerequisites
■

You must be a Cluster Administrator. This user classification is required to
create and configure a service group.

■

You must be a Local Administrator on the node where you run the wizard.

■

Verify that SFW HA, along with the VCS database agent for Microsoft SQL, is
installed on all cluster nodes. See “Installing the Microsoft SQL database
agent” on page 47 for instructions.

■

Verify a VCS cluster is configured using VCS Configuration Wizard (VCW).

■

Verify the SQL Server instance to me made highly available is installed
identically on all nodes that will participate in the service group.

■

Verify the shared volumes created to store SQL Server data files and registry
replication information are mounted on the node where you run the wizard
and unmounted from other nodes in the cluster. See “Mounting volumes” on
page 31 for instructions.
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■

Assign a unique virtual server name and IP address to SQL Server instance.

■

Make sure the SQL Server service is stopped for the SQL instance, which you
will be configuring in the service group.

Configuring SQL Server in a VCS cluster
VCS provides a SQL configuration wizard that guides you through the process of
configuring a SQL Server service group. The wizard also modifies and deletes a
SQL Server service group.
This section describes the steps required to create a new SQL Server service
group using the wizard. To modify an existing service group, see “Modifying a
SQL Server service group” on page 75.
Before configuring the service group, review the resource types and the
attribute definitions of the SQL Server agents, described in
Appendix A, “Resource type definitions” on page 99. For sample configuration
files and resource dependency graphs of the SQL Server service group, see
Appendix C, “Sample configurations” on page 119.
Note: Symantec recommends that you configure Microsoft Exchange Server and
Microsoft SQL Server on separate failover nodes within a cluster.
To create an SQL Server service group
1

Start the SQL configuration wizard. Click Start > All Programs > Symantec >
Veritas Cluster Server > Configuration Wizards > Database Agent for SQL
Server > SQL Server Configuration Wizard.

2

In the Select Configuration Option panel, click MS-SQL Server - Service
Group Configuration, click Create, and then click Next.

3

Review the prerequisites for configuring a SQL Server service group and
click Next.
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4

On the Service Group Configuration panel, specify the service group name
and system priority list and click Next.
The wizard starts validating your configuration. Various messages indicate
the validation status.

Service Group Name

Type a name for the SQL Server service group.

Available Cluster Systems

Select the systems on which to configure the
service group and click the right-arrow to move
the systems to the Systems in Priority Order
box.

Systems in Priority Order

This list represents the service group’s system
list. To remove a system from the service
group’s system list, select the a system and click
the left arrow. To change a system’s priority in
the service group’s system list, select the
system and click the up and down arrows. The
system at the top of the list has the highest
priority while the system at the bottom of the
list has the lowest priority.
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5

On the SQL Server Instance Selection panel, select the SQL Server instance
to be made highly available and click Next.

The wizard shows all the SQL Server instances, for SQL Server 2000 and
SQL Server 2005, installed on the cluster nodes.
Microsoft SQL Server 2000
Instances

To configure a SQL Server 2000 instance, click
Microsoft SQL Server 2000 Instances and then
check the box adjacent to the instance name.
Check the box in the MSSS column to make the
associated MSSearch service highly available.
To select the dependent services, you must
select the corresponding SQL instance.

Microsoft SQL Server 2005
Instances

To configure a SQL Server 2005 instance, click
Microsoft SQL Server 2005 Instances and then
check the box adjacent to the instance name.
Check the box in the MSSS column to make the
associated MSSearch service highly available.
Check the box in the SQLAgent column to make
the associated SQL agent service highly
available.
Check the box in the OLAP column to make the
associated Analysis service highly available.
To select the dependent services, you must
select the corresponding SQL instance.
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6

On the User Databases List panel, verify the databases configured for the
SQL instances and click Next.

The SQL Instance drop-down list box contains all the instances selected on
the SQL Server Instance Selection panel, in step 5 on page 54. Select a SQL
instance to see the master database configured for the instance. The wizard
will create MountV resource for the master database.
If you add user defined databases for a SQL instance, make sure you run the
SQL configuration wizard in modify mode. This ensures the user defined
databases are included in the VCS configuration. See “Modifying a SQL
Server service group” on page 75 for instructions.
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7

On the Detail Monitoring Configuration panel, configure detail monitoring
of SQL Server database, if required, and click Next.

SQL Instance List

Check the box adjacent to the SQL Server
instance for which you want to configure detail
monitoring. Only the instances selected in
step 5 on page 54 will be available for selection.

Domain\Username

Type the fully qualified user name for
connecting to SQL Server database. Make sure
the specified user has SQL Server login
permissions

Password

Type the password for the user name specified
in the Domain\Username field.

Global

Click Global if the path of the monitor script is
the same on all nodes and then click SQL
Monitor Script and type the path for the
monitor script.

Per System

Click Per System if the path of the monitor
script is different on all the nodes and then
click SQL Monitor Script and type the path for
the monitor script for each system.
Make sure that the specified path exists on all
the systems in the cluster.
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Fail over service group if
detail monitoring script
execution fails

Check this option if you want the SQL service
group to fail over when the detail monitor
script execution fails.

Apply

Click Apply to configure detail monitoring for
the selected SQL instance.
Repeat this for all instances that you want to
configure detail monitoring for.

8

On the Registry Replication Path panel, specify the location where the
registry replication information will be stored and click Next.
Symantec recommends that the mount path for RegRep resources be
different from the mount path SQL data files.

9

On the Virtual Server Configuration panel, specify the information related
to the virtual server and click Next.

Virtual Server Name

Type a virtual name for the node. This is the
server\instance name that is used by the SQL
Server 2000 clients to access the database.
Ensure that the virtual computer name you
enter is unique in the cluster.

Virtual IP Address

Type a unique virtual IP address for the SQL
Server.
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Subnet Mask

Type the subnet mask to which the virtual IP
address belongs.

Advanced

Click Advanced... to specify additional details
for the Lanman resource.
1

On the Lanman Advanced Configuration dialog
box, check AD Update required to enable the
Lanman resource to update the Active Directory
with the virtual name.

2

From the Organizational Unit drop-down list,
select the distinguished name for the virtual
server. By default, the Lanman resource adds
the virtual server to the default container
“Computer.”

3

Click OK.
The user account for VCS Helper service must
have adequate privileges on the specified
container to create and update computer
accounts.

Adapter Display Name

This field displays the adapters associated with
a system. For each system in the cluster, select
the public network adapter name.
The wizard displays all TCP/IP enabled
adapters on a system, including the private
network adapters, if they are TCP/IP enabled.
Ensure that you select the adapters to be
assigned to the public network, and not those
assigned to the private network.
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10 On the Service Group Summary panel, review the service group
configuration and change the resource names, if desired, and click Next.

The Resources box lists the configured resources. Click a resource to view
its attributes and their configured values in the Attributes box.
The wizard assigns unique names to resources. Change names of the
resources, if desired. To edit a resource name, select the resource name and
either click it or press the F2 key. Edit the resource name, and press the
Enter key to confirm the changes. To cancel editing a resource name, press
the Esc key.
11 Click Yes on the message that prompts you that the wizard will run
commands to modify the service group configuration. Various messages
indicate the status of these commands. The wizard marks all the resources
in the service group as CRITICAL. Use Cluster Manager (Java Console) or the
command-line to change their state, if required.
12 On the Configuration Complete panel, check Bring the service group online
to bring the configured service group online on the local system, and click
Next to configure additional SQL Server service groups (see “Configuring
SQL Server in a VCS cluster” on page 52) or an MSDTC Server service group
(see “Configuring MSDTC in a VCS cluster” on page 62.) Otherwise, click
Finish to exit the wizard.
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Configuring an MSDTC
service group
This section describes the steps involved in configuring an MSDTC service
group. Configuring an MSDTC service group involves configuring an MSDTC
service group and an MSDTC client.
VCS provides several ways to configure a service group, including the service
group configuration wizard, Cluster Manager (Java Console), Cluster Manager
(Web Console), and the command line. This chapter provides instruction on how
to use the configuration wizard to configure the MSDTC service group.

Prerequisites
■

You must be a Cluster Administrator. This user classification is required to
create and configure a service group.

■

You must be a Local Administrator on the node where you run the wizard.

■

Verify the VCS database agent for Microsoft SQL is installed on all cluster
nodes. See “Installing the Microsoft SQL database agent” on page 47 for
instructions.

■

Verify that the VCS cluster is configured using the VCS Configuration
Wizard (VCW).

■

Verify the MSDTC service is installed on all nodes that will participate in the
MSDTC service group.

■

Verify the shared volumes created to store MSDTC log files and registry
replication information are mounted on the node where you run the wizard
and unmounted from other nodes in the cluster. See “Mounting volumes” on
page 31 for instructions.

■

Assign a unique virtual server name and virtual IP address to MSDTC server.
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■

Make sure the Distributed Transaction Coordinator service is stopped.

Configuring MSDTC in a VCS cluster
Configuring MSDTC in a VCS cluster involves the following tasks:
■

Configuring an MSDTC service group. See “Configuring an MSDTC service
group” on page 62 for more information.

■

Configuring an MSDTC client. See “Configuring an MSDTC client” on
page 67 for more information.

Configuring an MSDTC service group
VCS provides a SQL configuration wizard that guides you through the process of
configuring an MSDTC service group. The wizard also modifies and deletes an
MSDTC service group.
Note: The wizard enables you to configure only one MSDTC service group in a
cluster.
This section describes the steps required to create a new MSDTC service group
using the wizard. To modify an existing service group, see “Modifying an
MSDTC service group” on page 78.
Before configuring the service group, review the resource types and the
attribute definitions of the MSDTC agent, described in Appendix A, “Resource
type definitions” on page 99. For sample configuration files and resource
dependency graphs of the SQL Server service group, see Appendix C, “Sample
configurations” on page 119.
To create an MSDTC service group
1

Start the SQL configuration wizard, if not already running. Click Start > All
Programs > Symantec > Veritas Cluster Server > Configuration Wizards >
Database Agent for SQL Server > SQL Server Configuration Wizard.

2

In the Select Configuration Option panel, click MSDTC Server - Service
Group Configuration, click Create, and click Next.

3

Review the prerequisites for configuring an MSDTC service group and click
Next.
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4

On the Service Group Configuration panel, specify the service group name
and system priority list and click Next.
The wizard starts validating your configuration. Various messages indicate
the validation status.

Service Group Name

Type a name for the MSDTC service group.

Available Cluster Systems

Select the systems on which to configure the
service group and click the right-arrow to move
the systems to the Systems in Priority Order
box.
Make sure you select the systems that are not in
the SystemList attribute for an Exchange
service group configured in the cluster

Systems in Priority Order

This list represents the service group’s system
list. To remove a system from the service
group’s system list, select the a system and click
the left arrow. To change a system’s priority in
the service group’s system list, select the
system and click the up and down arrows. The
system at the top of the list has the highest
priority while the system at the bottom of the
list has the lowest priority.
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5

On the Virtual Server Configuration panel, specify the information related
to the virtual server and click Next.

Virtual Server Name

Type a virtual name for the node. This is the
server name on which the DTC service is
running. Ensure that the virtual computer
name you enter is unique in the cluster.

Virtual IP Address

Type a unique virtual IP address for the MSDTC
Server.

Subnet Mask

Type the subnet mask to which the virtual IP
address belongs.
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Click Advanced Settings to specify additional
details for the Lanman resource.

Advanced Settings
1

On the Lanman Advanced Configuration dialog
box, check AD Update required to enable the
Lanman resource to update the Active Directory
with the virtual name.

2

From the Organizational Unit drop-down list,
select the distinguished name for the virtual
server. By default, the Lanman resource adds
the virtual server to the default container
“Computer.”

3

Click OK.
The user account for VCS Helper service must
have adequate privileges on the specified
container to create and update computer
accounts.

Adapter Display Name

6

This field displays the adapters associated with
a system. For each system in the cluster, select
the public network adapter name.
The wizard displays all TCP/IP enabled
adapters on a system, including the private
network adapters, if they are TCP/IP enabled.
Ensure that you select the adapters to be
assigned to the public network, and not those
assigned to the private network.

Specify the MSDTC log and replication directory and click Next. Make sure
the paths for both the directories are different. If the directory does not
exist, the wizard creates it.
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7

On the Service Group Summary panel, review the service group
configuration and change the resource names, if desired, and click Next.

The Resources box lists the configured resources. Click a resource to view
its attributes and their configured values in the Attributes box.
The wizard assigns unique names to resources. Change names of the
resources, if desired. To edit a resource name, select the resource name and
either click it or press the F2 key. Edit the resource name, and press the
Enter key to confirm the changes. To cancel editing a resource name, press
the Esc key.
8

Click Yes on the message that prompts you that the wizard will run
commands to modify the service group configuration. Various messages
indicate the status of these commands.

9

On the Configuration Complete panel, check Bring the service group online
to bring the configured service group online on the local system, and click
Next to configure an MSDTC client for the MSDTC server (see “Configuring
an MSDTC client” on page 67.) Otherwise, click Finish to exit the wizard.
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Configuring an MSDTC client
Configure an MSDTC client only if the MSDTC service group is configured on
nodes that do not have a SQL Server service group configured. Before
configuring the MSDTC client:
■

Verify the MSDTC service group is online in the cluster.

■

Verify the node on which you configure the client is not a part of an MSDTC
service group SystemList.

To configure an MSDTC client
1

Start the SQL configuration wizard, if not already running. Click Start > All
Programs> Symantec > Veritas Cluster Server > Configuration Wizards >
Database Agent for SQL Server > SQL Server Configuration Wizard.

2

In the Select Configuration Option panel, click MSDTC Client Configuration
and click Next.

3

Review the prerequisites for configuring an MSDTC client and click Next.
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4

On the System Selection panel, specify the nodes on which the MSDTC
client will be configured, and click Next.

Available Cluster Systems

Select the nodes from this list and click the
right arrow to add them to the Selected systems
list.
Make sure that you select only those systems
that are not in the SystemList attribute for an
Exchange service group configured in the
cluster.

Unavailable cluster
systems

Displays the nodes that have an MSDTC service
group configured. These nodes are not available
for setting up an MSDTC client.
Do not configure an MSDTC client on a node on
which an MSDTC server is configured.

5

On the Specify DTC Node panel, specify the MSDTC server for which the
client is being configured.

6

On the Configuration Complete panel, click Finish to exit the wizard.
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Verifying the service group
configuration
This chapter describes steps to verify a service group configuration by bringing
the service group online, taking it offline, and switching the service group to
another cluster node.

Bringing the service group online
This section describes steps required to bring the service group online.

From the Java Console
Perform the following steps to bring the service group online from the VCS Java
Console.
To bring the service group online
1

In the Cluster Explorer configuration tree, select the newly created service
group.

2

Right-click the service group name, and select Enable Resources. This
enables all resources in the service group.

3

Right-click the service group name, and select the systems on which to
enable the service group. (Right-click > Enable > system_name or Right-click
> Enable > All)

4

Save your configuration. (File > Close Configuration)

5

Right-click the service group and select to online the service group on the
system. (Right-click > Online > system_name)
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From the Web Console
Perform the following steps to bring the service group online from the Veritas
Cluster Management Console (Single Cluster Mode) also referred to as Web
Console.
To bring the service group online
1

On the Service Group page (Cluster Summary > All Groups > Service Group),
click Online.

2

In the Online Group dialog box, select the system on which to bring the
service group online. Click OK.

Switching the service group
This section describes steps required to switch the service group. The process of
switching a service group involves taking it offline on its current system and
bringing it online on another system.

From the Java Console
Perform the following steps to switch the service group from the VCS Java
Console.
To switch the service group online
1

In the Service Groups tab of the Cluster Explorer configuration tree,
right-click the service group.
or
Select the cluster in the Cluster Explorer configuration tree, select the
Service Groups tab, and right-click the service group icon in the view panel.

2

Choose Switch To, and choose the appropriate system from the pop-up
menu. (Right-click>Switch To>system_name)
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From the Web Console
Perform the following steps to switch the service group from the Veritas Cluster
Management Console (Single Cluster Mode) also referred to as Web Console.
To switch the service group online
1

From the Service Group page (Cluster Summary>All Groups>Service
Group), click Switch.

2

On the Switch Group dialog box, select the system to switch the service
group to.

3

Click OK.

Taking the service group offline
This section describes steps required to take the service group offline.

From the Java Console
Perform the following steps to take the service group offline from the VCS Java
Console.
To take the service group offline
1

In the Service Groups tab of the Cluster Explorer configuration tree,
right-click the service group.
or
Select the cluster in the Cluster Explorer configuration tree, select the
Service Groups tab, and right-click the service group icon in the view panel.

2

Choose Offline, and choose the appropriate system from the pop-up menu.
(Right-click>Offline>system_name)
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From the Web Console
Perform the following steps to take the service group offline from the Veritas
Cluster Management Console (Single Cluster Mode) also referred to as Web
Console.
To take the service group offline
1

On the Service Group page (Cluster Summary > All Groups > Service Group),
click Offline. This opens the Offline Group dialog box.

2

Select the system on which to take the service group offline.

3

Click OK.

Disabling the service group
To disable the agent, you must change the SQL Server service group to an
OFFLINE state. You can stop the application completely or switch the agent to
another system.

From the Java Console
Perform the following steps to disable the service group from the VCS Java
Console.
To disable the service group
1

In the Service Groups tab of the Cluster Explorer configuration tree,
right-click the service group.
or
Select the cluster in the Cluster Explorer configuration tree, select the
Service Groups tab, and right-click the service group icon in the view panel.

2

Choose Disable, and choose the appropriate system from the pop-up menu.

From the Web Console
Perform the following steps to disable the service group from the Veritas Cluster
Management Console (Single Cluster Mode) also referred to as Web Console.
To disable the service group
1

In the Service Group page (Cluster Summary>All Groups>Service Group),
click Disable. This opens the Disable Group dialog box.

2

Select the system on which to disable the service group. To disable the
service group on all systems, click All Systems.
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Uninstalling the agent
This chapter describes steps for uninstalling the VCS database agent for
Microsoft SQL using the installer for Storage Foundation for Windows.

Removing the SQL agent
Before uninstalling the agent:
■

Verify you have local administrator privileges on the node where you are
uninstalling the agent.

■

Verify the agent is not running when you attempt to remove it. If the agent
is removed while running, information about the resource type and the
service groups remains in the configuration files and causes VCS to fail.

■

Verify all SQL Server service groups are offline on all nodes in the cluster
and all SQL Server resource types are deleted.

To uninstall the agent
1

Start the installer for SFW. In the Add/Remove Programs applet, click
Storage Foundation 5.0 for Windows and click Change.

2

In the Storage Foundation 5.0 for Windows dialog box, click Add or Remove
and click Next.

3

In the SFW product options panel, click Next.

4

Uncheck the check box for Veritas Cluster Server Database Agent for SQL
and click Next.

74 Uninstalling the agent
Removing the SQL agent

5

The installer validates the system for prerequisites. After the system is
accepted, click Next.
If a system is rejected, the Comments column displays the cause for
rejecting the system. Highlight the system to view a detailed information
about the failure in the Details box. Resolve the error, highlight the system
from the list, and click Validate Again.

6

An informational message appears if you selected the DMP option. Review
the information and click OK to continue.

7

Review the summary of your selections and click Update to start the
uninstallation. The installer displays the status of uninstallation.

8

After the uninstallation is complete, review the report and click Next and
click Finish.
Repeat these steps on all systems where VCS database agent for Microsoft
SQL is to be uninstalled.
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Administering the service
group
This chapter describes the administrative tasks you can perform on SQL Server
and MSDTC service groups such as modifying the service group configuration
and deleting a service group. The chapter also describes steps to configure detail
monitoring for a SQL Server database.

Administering a SQL Server service group
The SQL configuration wizard enables you to modify a SQL Server service group
or delete the service group.

Modifying a SQL Server service group
You can modify the configuration of the service groups using the configuration
wizards, the Java Console, and the Cluster Management Console (Single Cluster
Mode) also referred to as the Web Console. This section describes the steps to
modify a SQL Server service group using the SQL configuration wizard.

Prerequisites
■

If the SQL Server service group is online, you must run the wizard from a
node on which the service group is online. You can then use the wizard to
add resources to and remove them from the configuration. You cannot
change resource attributes.

■

To change the resource attributes, you must take the service group offline.
However, the MountV and VMDg resources for the service group should be
online on the node where you run the wizard and offline on all other nodes.
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■

If you are running the wizard to remove a node from the service group’s
system list, do not run the wizard on the node being removed.

■

If you are running the wizard to add or remove MountV resources for user
defined databases, make sure the service group is online.

To modify a SQL Server service group
1

Start the SQL configuration wizard. Click Start> All Programs> Symantec >
Veritas Cluster Server> Configuration Wizards > Database Agent for SQL
Server > SQL Server Configuration Wizard.

2

In the Select Configuration Option panel, click MS-SQL Server - Service
Group Configuration, click Edit, and then click Next.

3

Review the prerequisites and click Next.

4

In the Service Group Selection panel, select the service group to modify and
click Next.

5

In the Service Group Configuration panel, add or remove systems from the
service group’s SystemList and click Next.

6

In the SQL Server Instance Selection panel, select the SQL Server instance to
be made highly available and click Next.

7

In the User Databases List panel, verify the master and user defined
databases configured for the SQL instance and click Next. The wizard will
create MountV resource for each database.

8

Follow the wizard instructions and make desired modifications to the
service group configuration. See “Configuring SQL Server in a VCS cluster”
on page 52 for instructions.
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Deleting a SQL Server service group
The following steps describe how to delete a SQL Server service group using the
configuration wizard.
To delete a SQL Server service group
1

Start the SQL configuration wizard. Click Start > All Programs > Symantec >
Veritas Cluster Server > Configuration Wizards > Database Agent for SQL
Server > SQL Server Configuration Wizard.

2

In the Select Configuration Option panel, click MS-SQL Server - Service
Group Configuration, click Delete, and then click Next.

3

Review the prerequisites and click Next.

4

In the Service Group Selection panel, select the service group to delete and
click Next.

5

In the Service Group Summary panel, click Next.

6

A message appears informing you that the wizard will run commands to
delete the service group. Click Yes to delete the service group.

7

Click Finish.
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Administering an MSDTC service group
The SQL configuration wizard enables you to modify an MSDTC service group or
delete the service group.

Modifying an MSDTC service group
You can modify the configuration of the service groups using the configuration
wizards, the Java Console, and the Cluster Management Console (Single Cluster
Mode) also referred to as the Web Console. This section describes the steps to
modify an MSDTC service group using the SQL configuration wizard.

Prerequisites
■

If the MSDTC service group is online, you must run the wizard from a node
on which the service group is online. You can then use the wizard to add
resources to and remove them from the configuration. You cannot change
resource attributes.

■

To change the resource attributes, you must take the service group offline.
However, the MountV and VMDg resources for the service group should be
online on the node where you run the wizard and offline on all other nodes.

■

If you are running the wizard to remove a node from the service group’s
system list, do not run the wizard on the node being removed.

To modify an MSDTC service group
1

Start the SQL configuration wizard, if not already running. Click Start > All
Programs > Symantec > Veritas Cluster Server > Configuration Wizards >
Database Agent for SQL Server > SQL Server Configuration Wizard.

2

In the Select Configuration Option panel, click MSDTC Server - Service
Group Configuration, click Edit, and then click Next.

3

Review the prerequisites and click Next.

4

In the Service Group Selection panel, select the service group to modify and
click Next.

5

Follow the wizard instructions and make desired modifications to the
service group configuration. See “Configuring an MSDTC service group” on
page 62 for instructions.
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Deleting an MSDTC service group
The following steps describe how to delete a SQL Server service group using the
configuration wizard.
To delete an MSDTC service group
1

Start the SQL configuration wizard. Click Start > All Programs > Symantec >
Veritas Cluster Server > Configuration Wizards > Database Agent for SQL
Server > SQL Server Configuration Wizard.

2

In the Select Configuration Option panel, click MSDTC Server - Service
Group Configuration, click Delete, and then click Next.

3

Review the prerequisites and click Next.

4

In the Service Group Selection panel, select the service group to delete and
click Next.

5

In the Service Group Summary panel, click Next.

6

A message appears informing you that the wizard will run commands to
delete the service group. Click Yes to delete the service group.

7

Click Finish.
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Detail monitoring of a SQL Server database instance
Use detail monitoring capability of VCS database agent for Microsoft SQL to
monitor the status of a database. Before setting up detail monitoring, you must
have the SQL Server agent running at the basic level of monitoring, that is, the
DetailMonitor attribute must be set to 0.)
The SQL Server agent uses a script to monitor the status of the database. A
sample SQL script, located at
%VCS_HOME%\bin\SQLServer<2000/2005>\sample_script.sql, is
provided with the agent for the purpose. If the script is successfully executed
during monitoring, the agent considers the database instance available. If the
execution fails, the database instance is considered not available and the service
group faults and fails over to the failover nodes. You can customize the script to
meet your configuration requirements.
Note: You should use a separate script for each SQL Server service group that
exists in the cluster. The script should exist on all the nodes in the service group.

Enabling detail monitoring
The following steps describe how to enable detail monitoring using the
configuration wizard.
To enable detail monitoring
1

Start the SQL configuration wizard. Click Start > All Programs> Symantec >
Veritas Cluster Server > Configuration Wizards > Database Agent for SQL
Server > SQL Server Configuration Wizard.

2

In the Select Configuration Option panel, click MS-SQL Server - Service
Group Configuration, click Edit, and then click Next.

3

Review the prerequisites and click Next.

4

In the Service Group Selection panel, select the service group configured for
the instance to be monitored in detail and click Next.

5

In the SQL Server Instance Selection panel, click Next.
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6

In the Detail Monitoring Configuration panel, specify information to enable
detail monitoring, and click Next.

SQL Instance List

Check the box adjacent to the SQL Server
instance for which you want to configure detail
monitoring. Only the instances selected in
step 5 on page 80 will be available for
selection.

Domain\Username

Type the fully qualified user name for
connecting to SQL Server database. Make sure
the specified user has SQL Server login
permissions

Password

Type the password for the user name specified
in the Domain\Username field.

Global

Click Global if the path of the monitor script is
the same on all nodes and then click SQL
Monitor Script and type the path for the
monitor script.

Per System

Click Per System if the path of the monitor
script is different on all the nodes and then
click SQL Monitor Script and type the path for
the monitor script.
Make sure that the specified path exists on all
the systems in the cluster.
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7

Fail over service group if
detail monitoring script
execution fails

Check this option if you want the SQL service
group to fail over when the detail monitor
script execution fails.

Apply

Click Apply to configure detail monitoring for
the selected SQL instance.
Repeat this for all instances that you want to
configure detail monitoring for.

Follow the wizard instructions and accept the default values in the
subsequent wizard panels. See “Configuring SQL Server in a VCS cluster” on
page 52 for instructions.
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Disabling detail monitoring
The following steps describe how to disable detail monitoring using the
configuration wizard.
To disable detail monitoring
1

Start the SQL configuration wizard. Click Start > All Programs> Symantec >
Veritas Cluster Server > Configuration Wizards > Database Agent for SQL
Server > SQL Server Configuration Wizard.

2

In the Select Configuration Option panel, click MS-SQL Server - Service
Group Configuration, click Edit, and then click Next.

3

Review the prerequisites and click Next.

4

In the Service Group Selection panel, select the service group configured for
the instance for which detail monitoring is being disabled, and then click
Next.

5

In the SQL Server Instance Selection panel, click Next.

6

In the Detail Monitoring Configuration panel, uncheck the check box
corresponding to the SQL Server instance for which detail monitoring is
being disabled and click Next.

7

Follow the wizard instructions and accept the default values in the
subsequent wizard panels. See “Configuring SQL Server in a VCS cluster” on
page 52 for instructions.
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Troubleshooting
This chapter describes how to troubleshoot common problems in the VCS
database agent for Microsoft SQL. The chapter lists the error messages, and
describes the problem associated with the agent. Recommended solution is
included, where applicable.

VCS logging
VCS generates two error message logs: the engine logs and the agent logs. Log
file names are appended by letters. Letter A indicates the first log file, B the
second, C the third, and so on.
The agent log is located at %VCS_HOME%\log\agent_A.txt. The format of agent
log messages is:
Timestamp (Year/MM/DD) | Mnemonic | Severity | UMI | Agent Type |
Resource Name | Entry Point | Message Text
A typical agent log resembles:
2004/01/12 11:22:47 VCS NOTICE V-16-20020-10 SQLServer2000
:SQLGrp-SQLServer2000:monitor:SQL Server Instance name is not
specified. Agent will operate on the default instance.

Here,
■

Timestamp denotes the date and time when the message was logged.

■

Mnemonic denotes which Symantec product logs the message. For VCS
database agent for Microsoft SQL, mnemonic is ‘VCS’.

■

Severity denotes the seriousness of the message. Severity of the VCS error
messages is classified into the following types:
■

CRITICAL indicates a critical error within a VCS process. Contact
Technical Support immediately.

■

ERROR indicates failure of a cluster component, unanticipated state
change, or termination or unsuccessful completion of a VCS action.
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■

WARNING indicates a warning or error, but not an actual fault.

■

NOTE informs the user that VCS has initiated an action.

■

INFO informs the user of various state messages or comments.
Of these, CIRITCAL, ERROR, and WARNING indicate actual errors.
NOTE and INFO provide additional information.

■

UMI or Unique Message ID is a combination of Originator ID, Category ID,
and Message ID. For example, the UMI for a message generated by the
SQLServer agent would resemble: V-16-20024-13
Originator ID for all VCS products is ‘V-16.’ Category ID for SQLServer
agent is 20020, for MSDTC agent is 20021, while that for MSSearch agent is
20022. Message ID is a unique number assigned to the message text.

■

Message text denotes the actual message string.

You can view these message logs using Notepad or any text editor. All messages
are logged to the engine and the agent logs. Messages of type CRITICAL and
ERROR are written to the Windows event log.
The following table lists the messages of type ERROR and WARNING.
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Error messages and descriptions
The following table lists the messages of type ERROR and WARNING. Each
message includes a description and a recommended solution, if applicable.

Agent for SQL Server 2000
Table 9-1

SQL Server 2000 agent error messages

Message

Description

Invalid value specified for attribute
attribute name.

No value provided for the specified attribute.

Failed to lookup the account name
'account name'. Error = Error code.

Invalid user information specified for detail
monitoring.

Solution: Provide a value for the attribute.

Solution: Provide the correct user information
Failed to open the SCM handle. Error =
Error code.

The agent fails to get a handle to the Service
Control Manager (SCM). This could occur if the
specified SCM database does not exist or the
requested access is denied.
Solution: Verify that SCM can be run on the
host. See the associated Windows error code for
more information.

The service 'service name' is not in
stopped state.

The service is in an invalid state.

Failed to start the service 'service
name'. Error = Error code.

The agent failed to start the service.

SQL Server Instance name is not
specified. Agent will operate on the
default instance.

No value spaced-out for SQL Server instance
name. Agent would operate on the default SQL
Server instance.

Solution: Check the state of the service.

Solution: See the associated Windows error
code for more information.

The service 'service name' did not start The agent failed to start the service within the
within the specified time limit.
time limit as specified in the
SQLOnlineTimeout attribute.
The 'service name' service is not in
stopped or running state. State=state
name.

The service is in an invalid state.
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Table 9-1

SQL Server 2000 agent error messages (continued)

Message

Description

The 'service name' service is in state
name state, while the 'service name'
service is in state name state.

The SQL Server and the SQL agent service are
not in the same state. Both the services must be
in ONLINE state to bring the service group
online.

Failed to get the password attribute.
Error =Error code.

Incorrect encrypted password specified for
detail monitoring.
Solution: Provide a password that is encrypted
using the ‘VCSencrypt’ utility.

Failed to open the service 'service
name'. Error = Error code.

The agent failed to open the service from the
Service Control Manager.
Solution: Check whether the service is present
in the Service Control Manager.

The SQL Server service could be in PAUSE, PAUSE
The service 'service name' is not in
running state. Attempt to stop it might PENDING, or START PENDING state.
be unsuccessful.
Solution: Resume the service and then attempt
to stop it.
The service 'service name' did not stop. The agent failed to stop the service. See the
Error = Error code.
associated Windows error code for more
information.
The service 'service name' did not stop
within the specified timeout. Error =
Error code.

The agent failed to stop the service within the
time limit as specified in the
SQLOfflineTimeout attribute.

SQL script has failed with error error
code.

The SQL script for detail monitoring failed. See
the associated Windows error code for more
information.

Could not find the database path for
instance instance name. Please correct
the instance name specified.

The instance name specified for the SQL Server
instance is incorrect.

Mount specified does not contain the
database for instance instance name.
Please correct the mount path.

The specified mount does not contain the data
pertaining to a given instance name.

The password attribute has not been
configured.

The password attribute used for detail
monitoring is not configured.

Solution: Specify the correct SQL Server
instance name.

Solution: Specify the correct mount path.
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Table 9-1

SQL Server 2000 agent error messages (continued)

Message

Description

Failed to start the Sql script. (User =
user name, Domain = domain name)
Error: Error code.

The agent failed to execute the script for detail
monitoring. See the associated Windows error
code for more information.

Sql script failed. Script output: script
output

The SQL script failed to monitor the SQL Server
instance. See the script output for more
information.

Agent for MSSearch
Table 9-2

MSSearch agent error messages

Message

Description

The AppName attribute has not been
configured.

No value specified for the AppName attribute.

Failed to instantiate the Microsoft
Search COM object. Error = Error code.

MSSearch is not installed. See the associated
Windows error code for more information.

Failed to open the Microsoft Search
service. Error = Error code.

The agent failed to open the MSSearch service
from the Service Control Manager (SCM).

Solution: Specify a valid value for the AppName
attribute.

Solution: Check whether the service is present
in the Service Control Manager.
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Agent for MSDTC
Table 9-3

MSDTC agent error messages

Message

Description

Lanman attribute has not been
configured.

No value specified for the LanmanResName
attribute.
Solution: Specify a valid value for the
LanmanResName attribute.

MountResName attribute has not been
configured.

No value specified for MountResName
attribute.
Solution: Specify a valid value for the
MountResName attribute.

LogPath attribute has not been
configured.

No value specified for LogPath attribute.

Failed to open the SCM handle. Error =
Error code.

The agent fails to get a handle to the Service
Control Manager (SCM). This could occur if the
specified SCM database does not exist or the
requested access is denied.

Solution: Specify a valid value for the
MountResName attribute.

Solution: Verify that SCM can be run on the
host. See the associated Windows error code for
more information.
Failed to open the MSDTC service.
Error = Error code.

The agent failed to open the MSDTC service
from the Service Control Manager (SCM).
Solution: Check whether the service is present
in the Service Control Manager.

Failed to start the MSDTC service.
Error = Error code.

The agent failed to start the MSDTC service.
See the associated Windows error code for
more information.

The MSDTC log path is 'path name'.
Configured one is 'path name'.

The specified path for the MSDTC logs is
different from the actual path.
Solution: Specify the correct MSDTC log path.

The MSDTC service is not in running
state. Offline might be unsuccessful.

The MSDTC service could be in PAUSE, PAUSE
PENDING, or START PENDING state.
Solution: Resume the service and then attempt
to stop it.
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Table 9-3

MSDTC agent error messages (continued)

Message

Description

Failed to stop the MSDTC service. Error The MSDTC service could not be stopped. See
= Error code.
the associated Windows error code for more
information.
Failed to wait for the MSDTC service to
stop. Error = Error code.

The agent could not stop the service within the
specified time limit of 20 seconds. See the
associated Windows error code for more
information.

Agent for SQL Server 2005
Table 9-4

SQL Server 2005 agent error messages

Message

Description

Failed to convert the argument list.
Error = Error code.

This is a VCS internal error.

Invalid value specified for attribute
attribute name.

No value provided for the specified attribute.

Failed to initialize the SQLServer2005
agent.

The agent failed to initialize the
SQLServer2005 agent for SQL Server 2005.

Failed to open the SCM handle. Error =
Error code.

The agent fails to get a handle to the Service
Control Manager (SCM). This could occur if the
specified SCM database does not exist or the
requested access is denied.

Solution: Contact Symantec Technical Support.

Solution: Provide a value for the attribute.

Solution: Verify that SCM can be run on the
host. See the associated Windows error code for
more information.
The service service name is not in
stopped state.

The service is in an invalid state.
Solution: Check the state of the service.

Failed to start the service service name. The agent failed to start the service.
Error = Error code.
Solution: See the associated Windows error
code for more information.
SQL Server Instance name is not
specified. Agent will operate on the
default instance.

No value spaced-out for SQL Server instance
name. Agent would operate on the default SQL
Server instance.
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Table 9-4

SQL Server 2005 agent error messages (continued)

Message

Description

Failed to set the virtual computer name This is a VCS internal error.
in the environment of the service
Solution: Contact Symantec Technical Support.
service name. Error = Error code.
The service service name did not start
within the specified time limit.

The agent failed to start the service within the
time limit as specified in the
SQLOnlineTimeout attribute.

Failed to wait for the service service
name to start. Error = Error code.

This is a VCS internal error.

The service name service is not in
stopped or running state. State=state
name.

The service is in an invalid state.

Failed to get the password attribute.
Error = Error code.

Incorrect encrypted password specified for
detail monitoring.

Solution: Contact Symantec Technical Support.

Solution: Provide a password that is encrypted
using the ‘VCSencrypt’ utility.
Failed to convert the password
attribute. Error = Error code.

This is a VCS internal error.
Solution: Contact Symantec Technical Support.

Failed to open the service service name. The agent failed to open the service from the
Error = Error code.
Service Control Manager.
Solution: Check whether the service is present
in the Service Control Manager.
Failed to query the status of the service The agent failed to query the state of the
service name. Error = Error code.
service.
Solution: Check whether the service is present
in the Service Control Manager.
The service service name is not in
The SQL Server service could be in PAUSE, PAUSE
running state. Attempt to stop it might PENDING, or START PENDING state.
be unsuccessful.
Solution: Resume the service and then attempt
to stop it.
The service service name did not stop.
Error = Error code.

The agent failed to stop the service. See the
associated Windows error code for more
information.

The service service name did not stop
within the specified timeout. Error =
Error code.

The agent failed to stop the service within the
time limit as specified in the
SQLOfflineTimeout attribute.
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Table 9-4

SQL Server 2005 agent error messages (continued)

Message

Description

Sql script has failed with error error
code.

The SQL script for detail monitoring failed. See
the associated Windows error code for more
information.

Error occurred while getting the
process exit code. Error = Error code.

This is a VCS internal error.
Solution: Contact Symantec Technical Support.

WaitForSingleObject failed

This is a VCS internal error.

with error error code.

Solution: Contact Symantec Technical Support.

The password attribute has not been
configured.

The password attribute used for detail
monitoring is not configured.

Failed to start the Sql script. (User =
user name, Domain = domain name)
Error = Error code.

The agent failed to execute the script for detail
monitoring. See the associated Windows error
code for more information.

Unable to convert the buffer to
UNICODE. Error = Error code

This is a VCS internal error.

Sql script failed. Script output: output

The SQL script failed to monitor the SQL Server
instance. See the script output for more
information.

Failed to get the temporary file path.
Error: Error code

This is a VCS internal error.

Failed to create the temporary file.
Error = Error code.

This is a VCS internal error.

Failed read the temporary file. Error =
Error code.

This is a VCS internal error.

Failed to remove the virtual name
environment for the service service
name.

This is a VCS internal error.

Solution: Contact Symantec Technical Support.

Solution: Contact Symantec Technical Support.

Solution: Contact Symantec Technical Support.

Solution: Contact Symantec Technical Support.

Solution: Contact Symantec Technical Support.
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Agent for SQL Server 2005 agent service
Table 9-5

SQL Server 2005 Agent Service agent error messages

Message

Description

Failed to convert the argument list.
Error = Error code.

This is a VCS internal error.

Invalid value specified for attribute
attribute name.

No value provided for the specified attribute.

Failed to initialize the
SQLAgService2005 agent.

The agent failed to initialize the
SQLAgService2005 agent for the SQL Server
2005 Agent Service.

Solution: Contact Symantec Technical Support.

Solution: Provide a value for the attribute.

Solution: Verify whether the
SQLAgService2005 agent exists.
Failed to open the SCM handle. Error =
Error code.

The agent fails to get a handle to the Service
Control Manager (SCM). This could occur if the
specified SCM database does not exist or the
requested access is denied.
Solution: Verify that SCM can be run on the
host. See the associated Windows error code for
more information.

The service service name is not in
stopped state.

The service is in an invalid state.
Solution: Check the state of the service.

Failed to start the service service name. The agent failed to start the service.
Error = Error code.
Solution: See the associated Windows error
code for more information.
SQL Server Instance name is not
specified. Agent will operate on the
default instance.

No value spaced-out for SQL Server instance
name. Agent would operate on the default SQL
Server instance.

Failed to set the virtual computer name This is a VCS internal error.
in the environment of the service
Solution: Contact Symantec Technical Support.
service name. Error = Error code.
The service service name did not start
within the specified time limit.

The agent failed to start the service within the
time limit as specified in the
SQLOnlineTimeout attribute.

Failed to wait for the service service
name to start. Error =Error code.

This is a VCS internal error.
Solution: Contact Symantec Technical Support.

Troubleshooting
Error messages and descriptions

Table 9-5

SQL Server 2005 Agent Service agent error messages (continued)

Message

Description

The service name service is not in
stopped or running state. State=state
name.

The service is in an invalid state.

Failed to open the service service name. The agent failed to open the service from the
Error = Error code.
Service Control Manager.
Solution: Check whether the service is present
in the Service Control Manager.
Failed to query the status of the service The agent failed to query the state of the
service name. Error = Error code.
service.
Solution: Check whether the service is present
in the Service Control Manager.
The service service name is not in
The SQL Server service could be in PAUSE, PAUSE
running state. Attempt to stop it might PENDING, or START PENDING state.
be unsuccessful.
Solution: Resume the service and then attempt
to stop it.
The service service name did not stop.
Error = Error code.

The agent failed to stop the service. See the
associated Windows error code for more
information.

The service service name did not stop
within the specified timeout. Error =
Error code.

The agent failed to stop the service within the
time limit as specified in the
SQLOfflineTimeout attribute.

Failed to remove the virtual name
environment for the service service
name.

This is a VCS internal error.
Solution: Contact Symantec Technical Support.
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Agent for SQL Server 2005 analysis service
Table 9-6

SQL Server 2005 Analysis Service agent error messages

Message

Description

Failed to convert the argument list.
Error = Error code.

This is a VCS internal error.

Invalid value specified for attribute
attribute name.

No value provided for the specified attribute.

Failed to initialize the
SQLOlapService2005 agent.

The agent failed to initialize the
SQLOlapService2005 agent for the SQL Server
2005 Analysis Service.

Solution: Contact Symantec Technical Support.

Solution: Provide a value for the attribute.

Solution: Verify whether the
SQLOlapService2005 agent exists.
Failed to open the SCM handle. Error =
Error code.

The agent fails to get a handle to the Service
Control Manager (SCM). This could occur if the
specified SCM database does not exist or the
requested access is denied.
Solution: Verify that SCM can be run on the
host. See the associated Windows error code for
more information.

The service service name is not in
stopped state.

The service is in an invalid state.
Solution: Check the state of the service.

Failed to start the service service name. The agent failed to start the service.
Error = Error code.
Solution: See the associated Windows error
code for more information.
SQL Server Instance name is not
specified. Agent will operate on the
default instance.

No value spaced-out for SQL Server instance
name. Agent would operate on the default SQL
Server instance.

Failed to set the virtual computer name This is a VCS internal error.
in the environment of the service
Solution: Contact Symantec Technical Support.
service name. Error = Error code.
The service service name did not start
within the specified time limit.

The agent failed to start the service within the
time limit as specified in the
SQLOnlineTimeout attribute.

Failed to wait for the service service
name to start. Error =Error code.

This is a VCS internal error.
Solution: Contact Symantec Technical Support.
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Table 9-6

SQL Server 2005 Analysis Service agent error messages (continued)

Message

Description

The service name service is not in
stopped or running state. State=state
name.

The service is in an invalid state.

Failed to open the service service name. The agent failed to open the service from the
Error = Error code.
Service Control Manager.
Solution: Check whether the service is present
in the Service Control Manager.
Failed to query the status of the service The agent failed to query the state of the
service name. Error = Error code.
service.
Solution: Check whether the service is present
in the Service Control Manager.
The service service name is not in
The SQL Server service could be in PAUSE, PAUSE
running state. Attempt to stop it might PENDING, or START PENDING state.
be unsuccessful.
Solution: Resume the service and then attempt
to stop it.
The service service name did not stop.
Error = Error code.

The agent failed to stop the service. See the
associated Windows error code for more
information.

The service service name did not stop
within the specified timeout. Error =
Error code.

The agent failed to stop the service within the
time limit as specified in the
SQLOfflineTimeout attribute.

Failed to remove the virtual name
environment for the service service
name.

This is a VCS internal error.
Solution: Contact Symantec Technical Support.
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Appendix

A

Resource type definitions
This appendix lists resource type definitions and attribute definitions of the SQL
Server 2000 agents, SQL Server 2005 agents, and MSDTC agent.
The resource type represents the VCS configuration definition of the agent, and
specifies how the agent is defined in the configuration file main.cf. The
Attribute Definition table explains the attributes associated with the agent. The
Required Attributes table lists the attributes that must be configured for the
agent to function properly. The sample dependency graph depicts the resource
types, resources, and resource dependencies required to create the service
groups.
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SQL Server 2000 agents
SQL Server 2000 agents include agents for SQL Server 2000 and MSSearch
service.

Agent for SQL Server 2000
The agent for SQL Server 2000 is represented by the SQLServer2000 resource
type.

Resource type definition
type SQLServer2000 (
static i18nstr ArgList[] = {Instance,
"LanmanResName:VirtualName",
"MountResName:MountPath",
SQLOnlineTimeout, SQLOfflineTimeout,
DetailMonitor, FaultOnDMScriptFailure, SQLDetailMonitorTimeout,
Username, Domain, Password, SQLFile }
str Instance
str LanmanResName
int SQLOnlineTimeout = 90
int SQLOfflineTimeout = 90
boolean DetailMonitor = 0
boolean FaultOnDMScriptFailure = 1
int SQLDetailMonitorTimeout = 30
i18nstr Username
i18nstr Domain
str Password
i18nstr SQLFile
str MountResName
)
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Attribute definitions
Review the following information to familiarize yourself with the required agent
attributes for a SQLServer2000 resource type. This information will assist you
during the agent configuration.
Table A-1

SQL Server 2000 agent required attributes

Required Attributes

Type and
Dimension

Definition

Instance

string-scalar

Name of instance to monitor. If the
attribute is blank, the agent monitors the
default instance.

LanmanResName

string-scalar

The Lanman resource name on which the
SQL Server 2000 resource depends.

MountResName

string-scalar

The mount resource name on which the
SQL Server 2000 resource depends.

SQLOnlineTimeout

integer-scalar

Number of seconds that can elapse before
online entry point aborts. Default is 90.

SQLOfflineTimeout

integer-scalar

Number of seconds that can elapse before
offline entry point aborts. Default is 90.

Table A-2

SQL Server 2000 agent optional attributes

Optional Attributes

Type and
Dimension

Definition

DetailMonitor

boolean

Defines whether the agent performs
detail monitoring of SQL Server 2000
database. The value 0 indicates the agent
will not monitor the database in detail. The
value 1 indicates the agent will.
Default = 0
Note: If the attribute is set to 1, the
attributes Username, Password, Domain,
SQLDetailMonitorTimeOut, and SQLFile
must be assigned appropriate values.
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Table A-2

SQL Server 2000 agent optional attributes (continued)

Optional Attributes

Type and
Dimension

Definition

FaultOnDMScriptFailure

boolean

Defines whether the agent fails over the
service group if the detail monitoring
script execution fails.
Default = 1
The value 1 indicates that the agent fails
over the service group if detail monitoring
script fails to execute. The value 0
indicates that it does not.

SQLDetailMonitorTimeout

integer-scalar

Number of seconds that can elapse before
the detail monitor routine aborts. Default
is 30.

Username

string-scalar

The Microsoft Windows authentication
name when logging in to a database for
detail monitoring. This attribute must not
be null if “DetailMonitor” attribute is set
to 1.
Note: This attribute can take localized
values.

Domain

string-scalar

Domain for the user account. This
attribute is used to create a trusted
connection to the SQL Server 2000
instance if “DetailMonitor” attribute is set
to 1.
Note: This attribute can take localized
values.

Password

string-scalar

Password for logging in to a database for
detail monitoring. This attribute must not
be null if “DetailMonitor” attribute is set
to 1.

SQLFile

string-scalar

The location of the SQLFile executed
during a monitor cycle. This attribute must
not be null if the “DetailMonitor” attribute
is set to 1.
Note: This attribute can take localized
values.
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Sample dependency graph
The following example describes typical service groups configured to monitor
the state of SQL Server 2000 in a VCS cluster. A sample configuration
graphically depicts the resources and their dependencies within the service
group. For more information about these resources and resource types, see the
chapter VCS Resource Types and Agents in the Veritas Cluster Server
Administrator’s Guide.
In the sample dependency graph below, the shared disk group is configured
using Volume Manager Diskgroup (VMDg) resource. The virtual name for the
SQL Server is created using the Lanman resource. The service group IP address
for the SQL Server is configured using the IP and NIC resources. The MountV
mount point is created using the MountV resource. SQL Server 2000 registry is
replicated using the RegRep and RegRepMountV resources. The SQL Server
2000 resource comes online after each of these resources are brought online.
Figure A-1

SQL Server 2000 service group dependency graph
SQLServer 2000
RegRep

Lanman
MountV
IP

NIC

VMDg

RegRepMountV

103

104 Resource type definitions
SQL Server 2000 agents

Agent for MSSearch service
The agent for MSSearch service is represented by the MSSearch resource type.

Resource type definition
type MSSearch (
static i18nstr ArgList[] = { AppName }
str AppName
)

Attribute definitions
Review the following information to familiarize yourself with the required agent
attributes for an MSSearch resource type. This information will assist you
during the agent configuration.
Table A-3

MSSearch service agent required attribute

Required Attribute

Type and
Dimension

Definition

AppName

string-scalar

The name of MSSearch instance to be
monitored. See “MSSearch service” on page 10
for more information.
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Sample dependency graph
The following examples describe typical service groups configured to monitor
the state of MSSearch service in a VCS cluster. A sample configuration
graphically depicts the resources and their dependencies within the service
group. For more information about these resources and resource types, see the
chapter VCS Resource Types and Agents in the Veritas Cluster Server
Administrator’s Guide.
In the sample configuration shown in the dependency graph below, the shared
disk group is configured using Volume Manager Diskgroup (VMDg) resource.
The MSSearch service depends upon the SQL Server 2000 service. The virtual
name for the SQL Server is created using the Lanman resource. The service
group IP address for the SQL Server is configured using the IP and NIC
resources. The MountV mount point is created using the MountV resource. SQL
Server 2000 and MSSearch registry is replicated using the RegRep and
RegRepMountV resources. Different mounts are used for SQL Server 2000 and
MSSearch registry replication. The MSSearch resource comes online after each
of these resources are brought online.
Figure A-2

MSSearch service group dependency graph
MSSearch

SQL Server 2000
Lanman

RegRep
MountV

IP
RegRepMountV
NIC
VMDg

RegRep
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SQL Server 2005 agents
SQL Server 2005 agent includes agents for SQL Server 2005, SQL Agent service,
and SQL Server 2005 Analysis service.

Agent for SQL Server 2005
The agent for SQL Server 2005 is represented by the SQLServer2005 resource
type.

Resource type definition
type SQLServer2005 (
static i18nstr ArgList[] = {
Instance,"LanmanResName:VirtualName",
SQLOnlineTimeout, SQLOfflineTimeout,
DetailMonitor, FaultOnDMScriptFailure, SQLDetailMonitorTimeout,
Username, Domain, Password, SQLFile }
str Instance
str LanmanResName
int SQLOnlineTimeout = 90
int SQLOfflineTimeout = 90
boolean DetailMonitor = 0
boolean FaultOnDMScriptFailure = 1
int SQLDetailMonitorTimeout = 30
i18nstr Username
i18nstr Domain
str Password
i18nstr SQLFile
)
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Attribute definitions
Review the following information to familiarize yourself with the required agent
attributes for a SQLServer2005 resource type. This information will assist you
during the agent configuration.
Table A-4

SQL Server 2005 agent required attributes

Required Attributes

Type and
Dimension

Definition

Instance

string-scalar

Name of instance to monitor. If the
attribute is blank, the agent monitors the
default instance.

LanmanResName

string-scalar

The Lanman resource name on which the
SQL Server 2005 resource depends.

SQLOnlineTimeout

integer-scalar

Number of seconds that can elapse before
online entry point aborts. Default is 90.

SQLOfflineTimeout

integer-scalar

Number of seconds that can elapse before
offline entry point aborts. Default is 90.

Table A-5

SQL Server 2005 agent optional attributes

Optional Attributes

Type and
Dimension

Definition

DetailMonitor

boolean

Defines whether the agent performs
detail monitoring of SQL Server 2005
database. The value 0 indicates the agent
will not monitor the database in detail.
The value 1 indicates the agent will.
Default = 0.
Note: If the attribute is set to 1, the
attributes Username, Password, Domain,
SQLDetailMonitorTimeOut, and SQLFile
must be assigned appropriate values.
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Table A-5

SQL Server 2005 agent optional attributes (continued)

Optional Attributes

Type and
Dimension

Definition

FaultOnDMScriptFailure

boolean

Defines whether the agent fails over the
service group if the detail monitoring
script execution fails.
Default = 1
The value 1 indicates that the agent fails
over the service group if detail
monitoring script fails to execute. The
value 0 indicates that it does not.

SQLDetailMonitorTimeout

integer-scalar

Number of seconds that can elapse
before the detail monitor routine aborts.
Default is 30.

Username

string-scalar

The Microsoft Windows authentication
name when logging in to a database for
detail monitoring. This attribute must not
be null if “DetailMonitor” attribute is set
to 1.
Note: This attribute can take localized
values.

Domain

string-scalar

Domain for the user account. This
attribute is used to create a trusted
connection to the SQL Server 2005
instance if “DetailMonitor” attribute is
set to 1.
Note: This attribute can take localized
values.

Password

string-scalar

Password for logging in to a database for
in-depth monitoring. This attribute must
not be null if “DetailMonitor” attribute is
set to 1.

SQLFile

string-scalar

The location of the SQLFile executed
during a monitor cycle. This attribute
must not be null if the “DetailMonitor”
attribute is set to 1.
Note: This attribute can take localized
values.
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Sample dependency graph
The following example describes typical service groups configured to monitor
the state of SQL Server 2005 in a VCS cluster. A sample configuration
graphically depicts the resources and their dependencies within the service
group. For more information about these resources and resource types, see the
chapter VCS Resource Types and Agents in the Veritas Cluster Server
Administrator’s Guide.
In the sample dependency graph below, the shared disk group is configured
using Volume Manager Diskgroup (VMDg) resource. The virtual name for the
SQL Server is created using the Lanman resource. The service group IP address
for the SQL Server is configured using the IP and NIC resources. The MountV
mount point is created using the MountV resource. SQL Server 2005 registry is
replicated using the RegRep and RegRepMountV resources. The SQL Server
2005 resource comes online after each of these resources are brought online.
Figure A-3

SQL Server 2005 service group dependency graph
SQLServer 2005
RegRep

Lanman
MountV
IP

NIC

RegRepMountV

VMDg

Agent for SQL Server 2005 Agent service
The agent for SQL Server 2005 Agent service is represented by the
SQLAgService2005 resource type.

Resource type definition
type SQLAgService2005 (
static i18nstr ArgList[] = {
"SQLServer2005ResName:Instance",
"LanmanResName:VirtualName" }
str SQLServer2005ResName
str LanmanResName
)
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Attribute definitions
Review the following information to familiarize yourself with the required agent
attributes for a SQLAgService2005 resource type. This information will assist
you during the agent configuration.
Table A-6

SQL Server 2005 Agent service agent required attributes

Required Attributes

Type and
Dimension

Definition

SQLServer2005ResName string-scalar

The name of the SQLServer2005 resource on
which the SQL Server 2005 Agent service
resource depends.

LanmanResName

The Lanman resource name on which the SQL
Server 2005 resource depends.

string-scalar

Sample dependency graph
The following example describes typical service groups configured to monitor
the state of SQL Server 2005 Agent service in a VCS cluster. A sample
configuration graphically depicts the resources and their dependencies within
the service group. For more information about these resources and resource
types, see the chapter VCS Resource Types and Agents in the Veritas Cluster
Server Administrator’s Guide.
In the sample dependency graph below, the shared disk group is configured
using Volume Manager Diskgroup (VMDg) resource. The virtual name for the
SQL Server is created using the Lanman resource. The service group IP address
for the SQL Server is configured using the IP and NIC resources. The MountV
mount point is created using the MountV resource. SQL Server 2005 registry is
replicated using the RegRep and RegRepMountV resources.The SQL Server 2005
Agent service resource depends on the SQL Server 2005 resource. The SQL
Server 2005 Agent service resource comes online after each of these resources
are brought online.
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Figure A-4

SQL Server 2005 Agent Service service group dependency graph
SQLAgService2005

SQLServer 2005
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Lanman
MountV
IP

NIC

VMDg
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Agent for SQL Server 2005 Analysis service
The agent for SQL Server 2005 Analysis service is represented by the
SQLOlapService2005 resource type.

Resource type definition
type SQLOlapService2005 (
static i18nstr ArgList[] = {
"SQLServer2005ResName:Instance",
"LanmanResName:VirtualName" }
str SQLServer2005ResName
str LanmanResName
)

Attribute definitions
Review the following information to familiarize yourself with the required agent
attributes for a SQLOlapService2005 resource type. This information will assist
you during the agent configuration.
Table A-7

SQL Server 2005 Analysis service agent required attributes

Required Attributes

Type and
Dimension

Definition

SQLServer2005ResName string-scalar

The name of the SQLServer2005 resource on
which the SQL Server 2005 Analysis service
resource depends.

LanmanResName

The Lanman resource name on which the
SQL Server 2005 resource depends.

string-scalar
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Sample dependency graph
The following example describes typical service groups configured to monitor
the state of SQL Server 2005 Agent service in a VCS cluster. A sample
configuration graphically depicts the resources and their dependencies within
the service group. For more information about these resources and resource
types, see the chapter VCS Resource Types and Agents in the Veritas Cluster
Server Administrator’s Guide.
In the sample dependency graph below, the shared disk group is configured
using Volume Manager Diskgroup (VMDg) resource. The virtual name for the
SQL Server is created using the Lanman resource. The service group IP address
for the SQL Server is configured using the IP and NIC resources. The MountV
mount point is created using the MountV resource. SQL Server 2005 registry is
replicated using the RegRep and RegRepMountV resources.The SQL Server 2005
Analysis service resource depends on the SQL Server 2005 resource. The SQL
Server 2005 Analysis service resource comes online after each of these
resources are brought online.
Figure A-5

SQL Server 2005 Analysis Service service group dependency graph
SQLOlapService2005

SQLServer 2005

RegRep

Lanman
MountV
IP

NIC

VMDg

RegRepMountV
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MSDTC agent
The MSDTC agent is represented by the MSDTC resource type.

Resource type definition
type MSDTC (
static i18nstr ArgList[] = {"LanmanResName:VirtualName",
"MountResName:MountPath", LogPath }
str LanmanResName
str MountResName
i18nstr LogPath
)

Attribute definitions
Review the following information to familiarize yourself with the required agent
attributes for an MSDTC resource type. This information will assist you during
the agent configuration
Table A-8

MSDTC agent required attributes

Required Attributes Type and
Dimension

Definition

LanmanResName

string-scalar

Name of the Lanman resource on which the
MSDTC resource depends.

MountResName

string-scalar

The mount resource name on which the MSDTC
resource depends.

LogPath

string-scalar

The path for MSDTC logs. This attribute can
take localized values.
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Sample dependency graph
The following examples describe typical service groups configured to monitor
the state of an MSDTC service group in a VCS cluster. A sample configuration
graphically depicts the resources and their dependencies within the service
group. For more information about these resources and resource types, see the
chapter VCS Resource Types and Agents in the Veritas Cluster Server
Administrator’s Guide.
In the sample configuration shown in the dependency graph below, the shared
disk group is configured using Volume Manager Diskgroup (VMDg) resource.
The virtual name for the MSDTC Server is created using the Lanman resource.
The service group IP address for the MSDTC Server is configured using the IP
and NIC resources. The MountV mount point is created using the MountV agent.
MSDTC registry is replicated using the RegRep and RegRepMountV resources.
The MSDTC resource comes online after each of these resources are brought
online.
Figure A-6

MSDTC service group dependency graph
MSDTC
RegRep

Lanman
MountV
IP

NIC

RegRepMountV

VMDg
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Using the virtual MMC
viewer
VCS starts the MSDTC service in a cluster under the context of the virtual
server. Because the MMC snap-in is not aware of such a configuration, it is not
possible to view the transactions on the DTC virtual server from the node where
the MSDTC resource is online. VCS provides a virtual MMC viewer that enables
you to view the distributed transactions statistics on the DTC virtual server
from a node where the MSDTC resource is online.

Prerequisites
■

An MSDTC service group must be configured in the cluster.

■

The MSDTC service group must be online on the node where the virtual
MMC viewer will be run.

To view transactions from a node where MSDTC resource is online
1

Run the virtual DTC viewer. From the command prompt, type:
C:\>VCSVMMCView.exe

Running the Virtual DTC viewer will restart the COM+ services.
2

The Component Services MMC snap-in is launched.

3

From the left pane, navigate to Computers > My Computer > Distributed
Transaction Coordinator > Transaction Statistics.

You can view the distributed transactions performed under the context of the
virtual server name.
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To view transactions from any node in the domain
1

Start the Component Services MMC snap-in. (Start > All Programs >
Administrative Tools > Component Services)

2

From the left pane, expand Component Services.

3

Right-click Computers, choose New, and then choose Computer.

4

In the Add Computer dialog box, enter the virtual name for the MSDTC
server. The virtual server name will appear under Computers.

5

From the left pane, navigate to Computers > newly added virtual server >
Distributed Transaction Coordinator > Transaction Statistics.

You can view the distributed transactions performed under the context of the
virtual server name.
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Sample configurations
The sample configurations in this appendix describe typical service groups
configured to monitor the state of SQL Server 2000 and SQL Server 2005 in a
VCS cluster.

Sample configuration for a SQL Server 2000 cluster
The following sample configuration depicts a two node cluster. A SQL Server
service group with MSSearch instance is configured in the cluster. The MSDTC
service group is also configured on the same nodes
include "types.cf"
cluster MYCLUSTER (
UserNames = { admin = fQRjQLqNRmRRpZRlQO }
Administrators = { admin }
CredRenewFrequency = 0
CounterInterval = 5
)
system SYSTEM1 (
)
system SYSTEM2 (
)
group sql2k_sg (
SystemList = { SYSTEM1 = 0, SYSTEM@ = 1 }
)
IP sql2k_sg-IP (
Address = "10.182.147.149"
SubNetMask = "255.255.252.0"
MACAddress @SYSTEM1 = "00-11-43-D1-9F-E3"
MACAddress @SYSTEM2 = "00-11-43-D1-9E-74"
)
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Lanman sql2k_sg-Lanman (
VirtualName = VSQL2K
IPResName = sql2k_sg-IP
)
MSSearch sql2k_sg-MSSearch (
AppName = "SQLServer$SQL2K"
)
MountV sql2k_sg-MountV (
MountPath = "O:"
VolumeName = sysdata
VMDGResName = sql2k_sg-VMDg
)
MountV sql2k_sg-MountV-1 (
MountPath = "P:"
VolumeName = regrep
VMDGResName = sql2k_sg-VMDg
)
NIC sql2k_sg-NIC (
MACAddress @SYSTEM1 = "00-11-43-D1-9F-E3"
MACAddress @SYSTEM2 = "00-11-43-D1-9E-74"
)
RegRep sql2k_sg-RegRep-MSSQL (
MountResName = sql2k_sg-MountV-1
ReplicationDirectory = "\\RegRep\\sql2k_sg-RegRep-MSSQL"
Keys = {
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\SQL2K",
"HKLM\\SOFTWARE\\Microsoft\\MSSQLServer\\Client" }
ExcludeKeys = {
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\SQL2K\\Setup",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\SQL2K\\SQLServerAgent\\Subsystems",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\SQL2K\\Tracking" }
)
RegRep sql2k_sg-RegRep-MSSearch (
MountResName = sql2k_sg-MountV-1
ReplicationDirectory = "\\RegRep\\sql2k_sg-RegRep-MSSearch"
Keys = {
"HKLM\\Software\\Microsoft\\Search\\1.0\\Gathering
Manager\\Applications\\SQLServer$SQL2K",
"HKLM\\Software\\Microsoft\\Search\\1.0\\Gather\\Applications\\SQLS
erver$SQL2K",
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"HKLM\\Software\\Microsoft\\Search\\1.0\\Applications\\Applications
\\SQLServer$SQL2K",
"HKLM\\Software\\Microsoft\\Search\\1.0\\CatalogNames\\Applications
\\SQLServer$SQL2K",
"HKLM\\Software\\Microsoft\\Search\\1.0\\Indexer\\Applications\\SQL
Server$SQL2K",
"HKLM\\Software\\Microsoft\\Search\\1.0\\Databases\\Applications\\S
QLServer$SQL2K" }
)
SQLServer2000 sql2k_sg-SQLServer2000 (
Instance = SQL2K
LanmanResName = sql2k_sg-Lanman
MountResName = sql2k_sg-MountV
)
VMDg sql2k_sg-VMDg (
DiskGroupName = SQL2K_DG
DGGuid = bd9d1f73-aed9-4b36-bdbb-24e6e653f69e
)
sql2k_sg-SQLServer2000 requires sql2k_sg-MountV
sql2k_sg-SQLServer2000 requires sql2k_sg-Lanman
sql2k_sg-SQLServer2000 requires sql2k_sg-RegRep-MSSQL
sql2k_sg-MountV requires sql2k_sg-VMDg
sql2k_sg-RegRep-MSSQL requires sql2k_sg-MountV-1
sql2k_sg-MSSearch requires sql2k_sg-SQLServer2000
sql2k_sg-MSSearch requires sql2k_sg-RegRep-MSSearch
sql2k_sg-RegRep-MSSearch requires sql2k_sg-MountV-1
sql2k_sg-MountV-1 requires sql2k_sg-VMDg
sql2k_sg-IP requires sql2k_sg-NIC
sql2k_sg-Lanman requires sql2k_sg-IP
group MSDTC_SG (
SystemList = { SYSTEM1 = 0, SYSTEM2 = 1 }
)
IP MSDTC_SG-IP (
Address = "10.182.147.128"
SubNetMask = "255.255.252.0"
MACAddress @SYSTEM1 = "00-11-43-D1-9F-E3"
MACAddress @SYSTEM2 = "00-11-43-D1-9E-74"
)
Lanman MSDTC_SG-Lanman (
VirtualName = VDTC
IPResName = MSDTC_SG-IP
DNSUpdateRequired = 1
DNSCriticalForOnline = 1

121

122 Sample configurations
Sample configuration for a SQL Server 2000 cluster

)
MSDTC MSDTC_SG-MSDTC (
LanmanResName = MSDTC_SG-Lanman
MountResName = MSDTC_SG-MountV
LogPath = "\\MSDTC"
)
MountV MSDTC_SG-MountV (
MountPath = "L:"
VolumeName = log
VMDGResName = MSDTC_SG-VMDg
)
MountV MSDTC_SG-MountV-1 (
MountPath = "Q:"
VolumeName = regrep
VMDGResName = MSDTC_SG-VMDg
)
NIC MSDTC_SG-NIC (
MACAddress @SYSTEM1 = "00-11-43-D1-9F-E3"
MACAddress @SYSTEM2 = "00-11-43-D1-9E-74"
)
RegRep MSDTC_SG-RegRep (
MountResName = MSDTC_SG-MountV-1
ReplicationDirectory = "\\RegRep"
Keys = { "HKCR\\CID", "HKCR\\SVCID",
"HKLM\\Software\\Microsoft\\MSDTC\\Security" }
ExcludeKeys = {
"HKCR\\CID\\2d032e98-c348-4dc0-ba9b-a51c3f5330d0\\CustomProperties\
\Service\\Path" }
)
VMDg MSDTC_SG-VMDg (
DiskGroupName = MSDTC1
DGGuid = "1eb1a20f-4737-4bee-bdfc-c828c614fcf1"
)
requires group msdtc_rvg_sg online local hard
MSDTC_SG-IP requires MSDTC_SG-NIC
MSDTC_SG-Lanman requires MSDTC_SG-IP
MSDTC_SG-MSDTC requires MSDTC_SG-Lanman
MSDTC_SG-MSDTC requires MSDTC_SG-RegRep
MSDTC_SG-MSDTC requires MSDTC_SG-MountV
MSDTC_SG-RegRep requires MSDTC_SG-MountV-1
MSDTC_SG-MountV requires MSDTC_SG-VMDg
MSDTC_SG-MountV-1 requires MSDTC_SG-VMDg
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Sample configuration for a SQL Server 2005 cluster
The following sample configuration depicts a two node SQL Server cluster with
MSDTC server configured. A SQL Server service group with MSSearch service,
SQL Server Agent service, and SQL Server Analysis service is configured is
configured in the cluster. The MSDTC service group is also configured on the
same nodes.
include "types.cf"
cluster MYCLUSTER (
UserNames = { admin = GPQiPKpMQlQQoYQkPN }
ClusterAddress = "10.182.146.127"
Administrators = { admin }
CredRenewFrequency = 0
CounterInterval = 5
)
system SYSTEM1 (
)
system SYSTEM2 (
)
group SQL_SG (
SystemList = { SYSTEM1 = 0, SYSTEM2 = 1 }
)
GenericService SQL_SG-MSSearch (
ServiceName = "msftesql$FIRST"
)
IP SQL_SG-IP (
Address = "10.182.147.127"
SubNetMask = "255.255.252.0"
MACAddress @SYSTEM1 = "00-11-43-D1-9F-E3"
MACAddress @SYSTEM2 = "00-11-43-D1-9E-74"
)
Lanman SQL_SG-Lanman (
VirtualName = VSQL2K5
IPResName = SQL_SG-IP
)
MountV SQL_SG-MountV (
MountPath = "S:"
VolumeName = data
VMDGResName = SQL_SG-VMDg
)
MountV SQL_SG-MountV-1 (
MountPath = "R:"
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VolumeName = regrep
VMDGResName = SQL_SG-VMDg
)
NIC SQL_SG-NIC (
MACAddress @SYSTEM1 = "00-11-43-D1-9F-E3"
MACAddress @SYSTEM2 = "00-11-43-D1-9E-74"
)
RVGPrimary SQL_SG-RVGPrimary (
RvgResourceName = sql_rvg_sg-VvrRvg
)
RegRep SQL_SG-RegRep-MSSQL (
MountResName = SQL_SG-MountV-1
ReplicationDirectory = "\\RegRep\\SQL_SG-RegRep-MSSQL"
Keys @SYSTEM1 = {
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\MSSQLServer",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\Replication",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\SQLServerAgent",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\PROVIDERS",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\SQLServerSCP" }
Keys @SYSTEM2 = {
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\MSSQLServer",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\Replication",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\SQLServerAgent",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\PROVIDERS",
"HKLM\\SOFTWARE\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\SQLServerSCP" }
ExcludeKeys = { "" }
)
RegRep SQL_SG-RegRep-MSSearch (
MountResName = SQL_SG-MountV-1
ReplicationDirectory = "\\RegRep\\SQL_SG-RegRep-MSSearch"
Keys @SYSTEM1 = {
"HKLM\\Software\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\MSSearch\\GlobalAdminBlob" }
Keys @SYSTEM2 = {
"HKLM\\Software\\Microsoft\\Microsoft SQL
Server\\MSSQL.1\\MSSearch\\GlobalAdminBlob" }
ExcludeKeys = { "" }
)
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SQLAgService2005 SQL_SG-SQLAgService (
SQLServer2005ResName = SQL_SG-SQLServer2005
LanmanResName = SQL_SG-Lanman
)
SQLOlapService2005 SQL_SG-SQLOlapService (
SQLServer2005ResName = SQL_SG-SQLServer2005
LanmanResName = SQL_SG-Lanman
)
SQLServer2005 SQL_SG-SQLServer2005 (
Instance = FIRST
LanmanResName = SQL_SG-Lanman
)
VMDg SQL_SG-VMDg (
DiskGroupName = sql2k5_dg
DGGuid = "3ecadf51-2ad5-48da-b93a-0a193718fb94"
)

SQL_SG-SQLServer2005 requires SQL_SG-MountV
SQL_SG-SQLServer2005 requires SQL_SG-RegRep-MSSQL
SQL_SG-SQLServer2005 requires SQL_SG-Lanman
SQL_SG-MountV requires SQL_SG-VMDg
SQL_SG-RegRep-MSSQL requires SQL_SG-MountV-1
SQL_SG-MountV-1 requires SQL_SG-VMDg
SQL_SG-IP requires SQL_SG-NIC
SQL_SG-Lanman requires SQL_SG-IP
SQL_SG-MSSearch requires SQL_SG-SQLServer2005
SQL_SG-MSSearch requires SQL_SG-RegRep-MSSearch
SQL_SG-RegRep-MSSearch requires SQL_SG-MountV-1
SQL_SG-SQLAgService requires SQL_SG-SQLServer2005
SQL_SG-SQLOlapService requires SQL_SG-SQLServer2005
group MSDTC_SG (
SystemList = { SYSTEM1 = 0, SYSTEM2 = 1 }
)
IP MSDTC_SG-IP (
Address = "10.182.147.128"
SubNetMask = "255.255.252.0"
MACAddress @SYSTEM1 = "00-11-43-D1-9F-E3"
MACAddress @SYSTEM2 = "00-11-43-D1-9E-74"
)
Lanman MSDTC_SG-Lanman (
VirtualName = VDTC
IPResName = MSDTC_SG-IP
DNSUpdateRequired = 1
DNSCriticalForOnline = 1
)
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MSDTC MSDTC_SG-MSDTC (
LanmanResName = MSDTC_SG-Lanman
MountResName = MSDTC_SG-MountV
LogPath = "\\MSDTC"
)
MountV MSDTC_SG-MountV (
MountPath = "L:"
VolumeName = log
VMDGResName = MSDTC_SG-VMDg
)
MountV MSDTC_SG-MountV-1 (
MountPath = "Q:"
VolumeName = regrep
VMDGResName = MSDTC_SG-VMDg
)
NIC MSDTC_SG-NIC (
MACAddress @SYSTEM1 = "00-11-43-D1-9F-E3"
MACAddress @SYSTEM2 = "00-11-43-D1-9E-74"
)
RegRep MSDTC_SG-RegRep (
MountResName = MSDTC_SG-MountV-1
ReplicationDirectory = "\\RegRep"
Keys = { "HKCR\\CID", "HKCR\\SVCID",
"HKLM\\Software\\Microsoft\\MSDTC\\Security" }
ExcludeKeys = {
"HKCR\\CID\\2d032e98-c348-4dc0-ba9b-a51c3f5330d0\\CustomProperties\
\Service\\Path" }
)
VMDg MSDTC_SG-VMDg (
DiskGroupName = MSDTC1
DGGuid = "1eb1a20f-4737-4bee-bdfc-c828c614fcf1"
)
requires group msdtc_rvg_sg online local hard
MSDTC_SG-IP requires MSDTC_SG-NIC
MSDTC_SG-Lanman requires MSDTC_SG-IP
MSDTC_SG-MSDTC requires MSDTC_SG-Lanman
MSDTC_SG-MSDTC requires MSDTC_SG-RegRep
MSDTC_SG-MSDTC requires MSDTC_SG-MountV
MSDTC_SG-RegRep requires MSDTC_SG-MountV-1
MSDTC_SG-MountV requires MSDTC_SG-VMDg
MSDTC_SG-MountV-1 requires MSDTC_SG-VMDg
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